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Micro Focus Visual COBOL 4.0 for Eclipse
Distributed Edition Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

i Note:

» This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

» Check the Product Documentation section of the Micro Focus SupportLine Web site for any
updates to the documentation which might have been uploaded.

Product overview

The Micro Focus Visual COBOL for Eclipse Distributed Edition package comprises the following products
which you can download from your Electronic Product Delivery Note:

« Visual COBOL for Eclipse - the product provides an Eclipse-based integrated COBOL development
environment for Windows or Linux. Visual COBOL for Eclipse provides COBOL JVM support and
enhanced compatibility with ACUCOBOL and can be used standalone for developing local applications
or in conjunction with the Visual COBOL Development Hub to develop remote projects in Linux and
UNIX.

« Visual COBOL Development Hub - the product provides a rich desktop development environment based
on the Eclipse IDE with high-performance server-based tools for managing builds, source code access
and the debugger engine. Visual COBOL Development Hub also provides a central administration site,
simplifying the development tool distribution and maintenance process.

Upgrading from earlier Micro Focus products

Version 4.0 of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with an earlier version of your
product might not be compatible with version 4.0 run-time products. If the behavior of your application
changes with version 4.0, we strongly recommend that you relink the main executable with version 4.0.
This will ensure that the COBOL run-time system fully handles any run-time error conditions that might
occur.

A new executable that is fully compatible with version 4.0 can be produced without recompiling the
application, as long as the original object code is available and it is relinked with version 4.0.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Eclipse, Visual COBOL 4.0 can automatically relink existing projects created with Visual
COBOL 3.0 that have executable link artefacts. Eclipse displays a warning in the Problems view that the
project requires relinking. It then offers a Quick Fix action for you to execute that will link your project with
the most recent version of the Run-Time System.

Micro Focus Visual COBOL 4.0 for Eclipse Distributed Edition Release Notes
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What's New

This release provides enhancements in the following areas:

Integration with Eclipse

Application Server JCA Support for Enterprise Server
Application Workflow Manager

Build Tools for Windows

Code Coverage

Codeset support

Compiler directives

Data File Tools

Database Connectors

Debugging

Docker

Documentation on working with large applications
Enterprise Server

File Handler

Managed COBOL

Library routines

Micro Focus Unit Test Framework

OpenESQL

Platform support

Integration with Eclipse

Back to Top

This release provides the following general enhancements:

Support for Eclipse 4.7 Oxygen (64-bit) and 64-bit project templates - the 64-bit Eclipse 4.7 is now
installed by default. Project templates are available for both 32-bit and 64-bit applications. You can set a
default project template (either 32-bit or 64-bit) to use so that all future new projects will use that as the
preference. On platforms only capable of building to 64-bit, the 64-bit templates are the default ones.

The 32-bit Eclipse is still supported on 64-bit Windows platforms, however you need to manually install
it and a 32-bit Java.

Support for Eclipse 4.4 and 4.5 has been discontinued.

Starting with release 4 Patch Update 4, you can plug Visual COBOL into Eclipse 4.8 (either 32-bit or 64-
bit) installed on your machine. On Red Hat, this requires that you have Red Hat 7 or later.

Support for SUSE 12 - only the 64-bit SUSE 12 platform is supported and you can only use the 64-bit
Eclipse with 64-bit projects on it.

(Native COBOL projects only) The Project Settings page in the project's properties now include a
search option. This enables you to find files and build configurations that have settings different from the
ones set at project level.

Remove File Directives - a context menu command in the explorer view enables you to reset a file's
directives.

IVP diagnostic tool enhancements - it is now possible to run the server-side IVP diagnostic tool for
diagnosing issues with a remote connection from within Eclipse installed at the client side. The IVP tool
now also performs a check for whether XTERM is installed on the remote machine.

IMTK service mappings are now automatically regenerated if you make a change to the interface fields
in the underlying program.

What's New
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6 | What's New

The following enhancements are available for JVM COBOL projects and package handling:

* New wizards for creating ENUM, DELEGATE and VALUETYPE types.

» Additional code snippets for Method-Id and Property-Id.

» Showing and grouping packages in the COBOL Explorer view - use the COBOL JVM Project
Presentation command from the View menu in the explorer to either display COBOL categories or
packages.

« Refactoring by renaming the package name - available from the context menus in the COBOL Editor
and in COBOL Explorer.

« Refactoring by moving source folders, packages or compilation units - available from the explorer
context menu.

» Support for switching off the package name mapping using the Each part of the package name
corresponds to a subdirectory option in the Build Configuration page.

» Support for packaging .class files in a .jar file when building COBOL JVM projects.

¢ Open Type Hierarchy and Open Call Hierarchy context menu commands - available in the COBOL
editor, COBOL Explorer and in the outline views while seeing the packages presentation in the IDE.

The following editor improvements are available:

* A Properties context menu command - enables you to access a file's properties directly from the editor.
* A Show In context menu command - enables you to locate the file in the COBOL Explorer.

« Edit > Convert Tabs to Spaces command - enables you to convert any tabs in your COBOL source
files to a specified number of spaces.

Automatic relinking of applications created with Visual COBOL 3.0:

« Visual COBOL 4.0 can automatically relink existing projects created with Visual COBOL 3.0 that have
executable link artefacts. Eclipse displays a warning in the Problems view that the project requires
relinking. It then offers a Quick Fix action for you to execute that will link your project with the most
recent version of the run-time system.

Application Server JCA Support for Enterprise Server
Back to Top
This release includes the following enhancements:

e COBOL Resource Adapters now support WebSphere 9.0 and WebLogic 12.2.1.
e Tomcat 7.0 support for servlet generation with J2SEBeans.

* NullSearch utility - for COBOL resource adapters, this new utility provides assistance in locating NULL
fields in mappings passed to Enterprise Server. When a large number of arguments is provided in the
parameters passed to Enterprise Server, it is difficult to locate NULL fields, which are not allowed. The
NullSearch utility isolates NULL fields, so the Java application can be corrected.

Application Workflow Manager

Back to Top

Improvements have been made in the following areas:
* Model editor - now includes:

* A new Edit action. Enables you to edit any model component instead of working with the Properties
view. The new action enables you to change the attribute values of several model components at a
time.

e An Outline and a Relationship Hierarchy view.

« Improved backwards and forwards navigation in the model.

« Automated sequence numbering in the model.

« The context menu of the model editor has been restructured for more clarity.



« Context help.

« Tool creation has been improved. Dependent components are generated from the function package
tool definition.
» Development of models:

* Newly created empty models now contain all categories. The new models also validate without any
errors or warnings.

« A new AWM system type, “Custom System”, is available. This system type supports the model
development process by facilitating the creation, change, load and reload of a model.

« New modelling features:

e The “Return Property Value” tool in the function package now supports several additional use cases.
« The “Transfer File” tool in the function package offers improved support for mass processing.
« Support for properties with an application-wide scope.

* A modelling capability to structure the local file cache for copybooks and include files downloaded by
the background parser in the editor. Additional tools are provided to check the existence of or clear
the file cache for copybooks and include files.

* The product help includes some tutorials showing how to create new models and extend the
functionality of existing models. See the Tutorials Guide.

« A number of template models are now available and can be used as a base to develop your own
models.

Build Tools for Windows
Back to Top

This release includes Visual COBOL Build Tools for Windows, a separately-installable component of Visual
COBOL that has been designed to be used in environments where you want to work with your COBOL
projects but you don't want the overheads associated with the Eclipse IDE.

Build Tools provide a lightweight, easy-to-install development environment that is well-suited for use in
Docker containers and continuous integration or continuous delivery systems.

Code coverage
Back to Top
This release provides the following enhancements:

« Support has been added in Eclipse for code coverage for procedural copybooks.

Codeset support
Back to Top

Support has been added to enable codeset mapping to additionally be configured to use IBM's Conversion
Tables directly instead of the Micro Focus supplied tables. You need to download IBM's conversion tables
from IBM's Web site. Then you can use the MFCODESET environment variable to convert between IBM's
CCSIDs.

Compiler directives
Back to Top
The following Compiler directives are new in this release:

* DISPSIGN - determines the display output of numeric fields with included signs, under an IBM
mainframe dialect only.

e GNTLITLINKSTD - stops the suppression of call-convention 8 when both call-convention 2 and call-
convention 8 are in effect for a . gnt file in an Intel x86 32-bit environment.

What's New
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8 | What's New

ILSMARTTRIM - trims any trailing spaces from a string item returned by the get property associated
with an alphanumeric item processed by ILSMARTLINKAGE.

MAINFRAME-FLOATING-POINT - specifies the format of a program'’s floating point data items: either
IBM hexadecimal format or IEEE format. This directive is supported in managed code only.

The following Compiler directives contain new parameters in this release:

CHECKDIV - a new parameter 'ACOS' now emulates a divide by zero operation on an ACOS
mainframe system: the quotient and the remainder are set to the value of the dividend.

OOCTRL - a new parameter, L, specifies whether to include directory location comments in .cls
and . ins inheritance files.

NUMPROC - a new parameter 'ACOS' provides partial compatibility with the behavior of NEC ACOS
COBOL processing of invalid data in USAGE DISPLAY data items and invalid sign information in
USAGE COMP-3 data items.

Data File Tools

Back to Top

It is now possible to export any filtered results. When filtering a data file, you can use the results to create a
new data file - click Search > Export Results when a filter is applied to save the filtered records to a new
file. You can:

Save the filtered records to a new file.

Save the records that match the specified filter (such as customer information or orders).
Download a subset of the data from a remote file.

Save a small portion of the data for testing purposes.

Database Connectors

Back to Top

Database Connectors for Microsoft SQL Server

The following enhancements have been made to Database Connectors for Microsoft SQL Server:

Database Connectors for MSSQL is now available on Linux/UNIX platforms where MSSQL server is
supported; see the Microsoft SQL Server support web pages for an up-to-date list of specific supported
platforms.

With Database Connectors for Microsoft SQL Server, you can connect to both an instance running on a
Linux machine, or an instance running on a Windows machine. You can also use it to connect to an
instance of SQL Server running on Linux from a Windows client. (Note that setting up SQL Server on a
Linux machine is beyond the scope of our documentation.)

See To install Database Connectors for Microsoft SQL Server for more information.

Database Connectors for MSSQL now supports connecting to a Microsoft SQL Server running a multi-
subnet failover cluster. To use this feature requires changes to the connection string sent to the server,
which is accomplished by using the following 4 new configuration variables:

e A_MSSQL_MULTI_SUBNET_FAILOVER - set to TRUE to enable a connection that supports
multisubnet failover support. If set to FALSE (the default) support is not enabled, and the other
configuration variables have no effect.

e A MSSQL_FAILOVER_PARTNER - the name of the failover partner used. Refer to your SQL Server
documentation for valid values.

« A MSSQL_FAILOVER_PARTNER_SPN - the name of the failover partner SPN used. Refer to your
SQL Server documentation for valid values.

e A MSSQL_SERVER_SPN - the name of the Server SPN. Refer to your SQL Server documentation
for valid values.



« Database Connectors for MSSQL now supports columns of type GUID for existing SQL tables. A new
configuration variable, A_MSSQL_IGNORE_GUID_COLUMNS, determines the behavior when handling
existing tables that contain a column of this type.

i Note: Database Connectors for MSSQL cannot create a new column of this type.

Database Connectors for ODBC

« Database Connectors for ODBC is now available, allowing you to use ODBC connectivity to access
supported databases from your COBOL programs. See Database Connectors for ODBC for more
information.

Debugging

Back to Top

This release includes the following enhancements:

The following enhancements have been made to reverse debugging and live recording:

« Reverse debugging and live recording have been enhanced significantly, and are now considered GA
features. You can now debug using watchpoints and conditional breakpoints, and reset execution points.
Debugging multi-threaded applications is now supported, and so are programs that contain OSVS
performs and nested programs.

« A command line utility, cobeslr, has been introduced to enable you to configure live recording for
particular services or application instances of an enterprise server region.

* You can now use the CBL_DEBUG_START and CBL_DEBUG_STORP library routines to start and stop a
live recording session.

Docker
Back to Top

This release provides support to enable you to run your COBOL applications in Docker containers, taking
advantage of the many benefits offered by the Docker platform such as portability, performance, agility,
isolation, and scalability.

Documentation on working with large applications
Back to Top

The product help now includes a new section, Working with a Large Code Base, that includes
recommendations and best practices for working with large applications inside the IDE. It includes tips on
how to structure your projects, how to optimize the performance of the IDEs, and step-by-step workflow
showing how to move an existing legacy application into Visual COBOL.

Enterprise Server
Back to Top
The following enhancements have been made to Enterprise Server:

« Conversation filtering - the Enterprise Server Communications Process (MFCS) can now restrict access
to listeners by client address. You can specify any permitted or forbidden addresses either by IP
address, network mask, or domain name, and use wildcards. Filters can be applied to individual
listeners, communications processes, or to entire regions. More specific filter rules override any general
ones.

e The Enterprise Server Security Facility now starts throttling Verify requests when it receives more than
100 requests per second.

This can be used to limit the effectiveness of denial-of-service and brute force attacks. You can
configure the value where throttling occurs. See Verify Request Throttling for more information.

What's New
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10 | What's New

» (Technology Preview only) Support for adding, deleting, and modifying XA resources in a live Enterprise
Server region.

It is now possible to add, edit, or delete XA resources while an enterprise server instance is running.
Any changes made come into effect after any in-flight transactions have completed. The ability to make
these changes in a live environment comes under the control of the existing enterprise server
permissions.

* XA-compliant Resources (XARS) - this release provides enhanced CTF tracing that allows more flexible
reporting of warnings and errors on the RM switch module level.

« A new Communications Server resource class - enables you to control the access to the Enterprise
Server Console Log and Communications Server Log when external security is in effect for an
enterprise server region; see Resource Classes for Communications Server for more information.

» Improved catalog availability - there is now an improved resilience to temporary communication issues
with the catalog and error reporting enabling a region to stay active if a region has multiple catalogs
defined and one of the catalogs is not available.

e Enhanced SSL/TLS certificate support - for communications with TLS (formerly SSL), additional
certificate and key file formats are supported. Servers may now be configured with both an RSA and an
ECC key and certificate.

« Enhanced SSL/TLS cipher configuration - for communications with TLS (formerly SSL), the permitted
cipher suites and their preferred order can now be configured. The minimum size of Diffie-Hellman
groups for DH key exchange can also be configured. The defaults have been made more secure.

« The Historical Statistics Facility (HSF) now enables you to write user-defined data to the records
produced within a .csv file. Use the ES_WRITE_CUSTOM_HSF or ESCSTHSF library routines within
your COBOL programs to define the custom data, and use the ES_HSF_CFG environment variable to
configure up to five custom fields in the generated record.

* You can also use the ES_HSF_CFG environment variable to configure the number of CICSF, TSQ, and
TDQ fields that are written to the record.

File Handler
Back to Top
This release provides the following enhancements:

e The DFSORT and SYNCSORT emulations now support the NULLOFL parameter of the OUTFIL
statement.

* The ASCIISOSI configuration option is how available. It adds the required SOSI characters to the
relevant EBCDIC DBCS character strings in order for them to be displayed or written out correctly.

Library routines
Back to Top
The following library routines contain new functionality:

« CBL_GET_OS_INFO - this library routine can now detect if the program is running within a Docker
container: cblte-osi-rts-capabilities parameter, bit7.

« CBL_DEBUG_START and CBL_DEBUG_STOP - these library routines have been enhanced to start
and stop a live recording session.

Managed COBOL
Back to Top
Deploying JVM COBOL to an Application Server:



* Running JVM COBOL under WebSphere 9.0 and WebLogic 12.2.1 is now supported.

Micro Focus Unit Test Framework
Back to Top
This release provides support for the following functionality:

« Generation of unit test stubs for selected entry points within your program.

OpenESQL
Back to Top
This release provides the following new features:

e Support for SQL Server 2017.

« The SQL(TRANSACTION) compiler directive has been enhanced to clearly define transaction
boundaries.

« A new SQL(NOWHERECURRENT) compiler directive that allows you to define updateable cursors that
do not do positioned updates or deletes with PostgreSQL or MySQL.

« Larger communication area (PID) that accommodates longer plan and program names.

e SQL(OPTIMIZECURSORS) has been enhanced for consistent and better cursor performance across all
OpenESQL backends.

Platform support
Back to Top
Note the following changes in platform support for this release:

* Windows 8 and Windows Server 2012 are no longer supported for developing applications. They are
still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.

* SUSE platforms - this release only supports SUSE Linux 12 SP2, 64-bit.

On this platform, you can only build COBOL programs to 64-bit executables. This applies when using
Eclipse on SUSE or with remote projects when Visual COBOL Development Hub is installed on SUSE.

What's New
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Significant Changes in Behavior or Usage

This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

* Application Workflow Modeller
e Code Coverage

e Codeset Support

e Common Communications Interface
e Communications Server

e Compiler

» Data Tools

* Documentation

e Enterprise Server

» Enterprise Server Auditing

« Executables require relinking

« File Handling

« IDE

* Interface Mapping Toolkit

e MF Server Administrator (GUI)
* Micro Focus Directory Server
* Run-Time System

Application Workflow Modeller
Back to the list

» Source or listing files are now opened in read-only mode when a browse action is executed in the
ChangeMan attachment model.

3138354 (1112546)

< A new function package, Micro Focus Background Parser, enables you to define the SYSLIB or
PROCLIB concatenation in which to search for COBOL copybooks, PL/I or JCL include files on the
mainframe or on network drives. The package also enables you to define any identifiers which
determine the structure of the local cache for COBOL copybooks, PL/I or JCL include files.

3132249 (1111922)

* The Endevor attachment application now validates the input of a CCID or a comment. They must not be
blank.

* Added the new "Modeled Edit Sessions Only" AWM model attribute to control whether modeled editor
actions should be available in non-modeled edit sessions.

Code Coverage
Back to the list

« Schema changes that affect the test coverage results generated from the tcuti 1 utility mean that if
you propagate the results to a third-party application (for example, an XSLT processor), and rely on the
<copyFileCoverage> element, you need to alter your transformations to focus on
<sourceFileCoverage> instead. The element was renamed to more appropriately reflect its
contents, as tcutil now gives global coverage for all source files (not just copybooks).

12 | Significant Changes in Behavior or Usage



Codeset Support
Back to the list

* Code-set mappings between ASCIlI and EBCDIC have been updated when Simplified Chinese is the
language in effect. ASCII table 5210 now maps to EBCDIC CCSID 836 for SBCS conversions. This
replaces the previously conversion (where ASCII table 1042 was used), which would convert the “\"
character to “$".

3124321 (1111464)

« New single-byte character set tables for MFCODESET have been added in order to improve support for
DB2 LUW - both for off-mainframe databases and for access to z/OS DB2. A number of existing
MFCODESET mappings have also been updated. See 'Supported Country Codes' for a full listing of
ASCII/ANSI <-> EBCDIC mappings.

3111843 (1109984)

Common Communications Interface

Back to the list

* You can now configure the Micro Focus Directory Server and enterprise server region’s listeners to only
use the server's configured SSL and TLS protocols and define a priority ordered cipher suite collection.
This forces connecting clients to use the server’s preferred ordered list of cipher suites when using the
specified protocols.

2866265 (1105526)

* In some circumstances it was possible for a connection to incorrectly accept the identity of an SSL/TLS
peer and allow a connection to complete when the connection should have been denied. This occurred
due to a failure to check the peer's entire identity certificate chain. This has now been fixed. NOTE: You
might need to correct your system’s configured certificate chains that fail verification checks at secure
connection creation time.

* In some circumstances it was possible to crash the CCITCP module when it was attempting to obtain
detailed error information about a closed connection. This has been fixed.

Communications Server
Back to the list

* TN3270 conversations to Enterprise Server now correctly handle the receive (idle) timeout setting
configured for the listener. There are also two new settings for configuring TN3270 timeouts, "Printers
time out” and "Output resets timeout". See the online product documentation for more information.

3144133 (1113024)

* Web access to the Enterprise Server Console Log and Communications Server Log is now restricted
when the region is secured using external security. Users will be required to provide a valid username
and password in order to view either log file. Web access to the logs can be controlled using the
standard ACL definitions under the new "Communications Server" Resource Class, with resources
"Enterprise Server Console Log" and "Communications Server Log". If these resources exist, users
require read access to be allowed to view the logs. If they do not exist, the default behavior is to allow
read access. The new resource class and resource definitions can be found in the
"es_default_|dap(_msuser/_unix).ldf" file in the bin or etc sub-directory of your product install directory.

3113539 (1110155)
* MFCS listeners can now be SSL-enabled without the need to have DemoCA installed.

2868627 (1105777)

* MFCS no longer initializes the Security Facility if there are no External Security Managers defined for
the region.

Significant Changes in Behavior or Usage | 13



Compiler
Back to the list

* Programs containing EVALUATE statements of the form: EVALUATE true | false WHEN conditional-
expression where conditional-expression included inline method invokes would give an RTS 114 error
when run as .int code, and an "lllegal .int code" error when generated. This has been fixed. Also, short
circuit evaluation is now correctly observed, such that when evaluating condition-1 AND condition-2, if
condition-2 contains an inline method invoke and condition-1 is false, then the inline method invoke is
not executed. Previously, despite being correctly evaluated, the inline method invoke in condition-2 was
being executed. Similar behavior relating to OR evaluations has also been corrected.

3138510 (1112492)

» During compilation, characters within literals that are unknown in the current locale are now less likely to
cause spurious errors. However, the correct (and safest) solution is to ensure that the locale has been
set correctly, to match the source encoding of these characters. On UNIX, this means setting LANG,
LC_CTYPE, or LC_ALL appropriately; each of these variables takes precedence over the former. On
Windows, this means setting the system locale in the 'Region and Language' section of Control Panel.

3123935 (1111148)

e The Compiler now produces an E level message - COBCH1888 Typedef is defined differently in another
external program - if different external programs have conflicting definitions of the same typedef name.
(To restore the previous behavior, where the earlier definition was ignored, use the directive
HIDEMESSAGE"1888".)

e An issue with the Compiler has been fixed so that in the RECORD VARYING clause, if the minimum
and maximum lengths are specified, the maximum length must be greater than the minimum length.

Data Tools
Back to the list

* Records with an invalid value for a conditional field will no longer result in a match for that conditional
layout.

2853226 (1103406)

Documentation
Back to the list

* You can use 'byte' or 'BYTE' as a synonym for the binary-char unsigned data type. As a result, 'byte’
and 'BYTE' are now reserved words in Managed COBOL. Use the REMOVE"BYTE" Compiler directive
to prevent an error being produced for existing programs that use the reserved word as a user-defined
word.

3147576 (1113323)

« As of version 3.0, references to types within an assembly other than mscorlib need to be explicitly
referenced. You can achieve this by using the ILREF Compiler directive. (Previously, in certain
circumstances, the Compiler would allow access to types within the System.dll assembly without the
need for an ILREF"System" directive.

3121002 (1111373)

Enterprise Server
Back to the list

e The External Security Facility (ESF) can now be configured to throttle large volumes of incoming Verify
(user authentication / signon) requests to improve resilience to denial-of-service and brute force attacks.
See "Verify Request Throttling" for more information.

3113639 (1110160)

14 | Significant Changes in Behavior or Usage



* The LDIF files used to create the sample configuration for Enterprise Server LDAP-based security no
longer create an empty "PHYSFILE" resource class. Changes in the JCL engine as of ES 3.0 caused
most jobs to fail when submitted to a security-enabled region using such a configuration. See the
product help for more information.

 The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports the
Argon2 hash algorithm for creating password verifiers. See MLDAP ESM Module Custom Configuration
Information in the product help for more information. NOTE: The Argon2 hash is optional and not
enabled by default.

« The MQ pages in ESMAC are now controlled by a new security resource, MQL. This enables you to
either restrict or grant users access. 'MQL*' is a new resource that needs to be added under MFESMAC
similar to existing resources such as 'PCT*' or 'XAT*'. The following is a sample export of the LDAP
repository:

FAEAAXAXAXAAAXAXAAXAXAAAXAAAXAXAAAAAAXAXAXKX

# Sample security definitions for ESMAC MQ Listeners/Writers pages

BHH

HHH##HE MQL* #t

HHEH A

dn: CN=MQL*,CN=MFESMAC,CN=Enterprise Server Resources,CN=Micro
Focus,CN=Program Data,DC=X

changetype: add

cn: MQL*

objectClass: microfocus-MFDS-Resource
microfocus-MFDS-Resource-Class: MFESMAC
microfocus-MFDS-Resource-ACE: allow:SYSADM group:alter
microfocus-MFDS-Resource-ACE: deny:*:execute
microfocus-MFDS-UID: mfuid

#description: Allow full access any ESMAC MQ Listeners/Writers Screen

3143258 (1112990)

* You can now use the ECIResponse.getReturnCode() method to obtain the return code for any errors
from Enterprise Server.

3142092 (1113248)

« Communication with the console daemon has been improved. Messages are displayed more quickly
and requests are being processed more efficiently and, as a result, times for initialization and shutdown
might be reduced.

3136867 (1112483)

* Administrators can now add, delete or modify XA resources in the Enterprise Server Administration
Web Ul while a region is running.

2589624 (1085625)

e In UNIX environments, DB2 and ODBC switch modules can now be enabled together in the same
region if the DB2 switch is built with the "-0" option.

3137455 (1112398)

Enterprise Server Auditing
Back to the list

* The maxRetryTime value in the audit configuration file now treats 0 as a no timeout time, and any
negative number as an infinite timeout.

3150566 (1113592)

« Any extra information that was added to the syslog messages will now correctly appear in the structured
data items.
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Executables require relinking or recompiling
i Note: Windows-only.

« Due to an internal change in version 4.0 of your product, you must at least relink any executable
programs compiled prior to this version, to make them compatible with the latest run-time system.
However, a full recompilation of your source code is the recommended action, to allow your executables
to benefit from the product's latest programming and performance enhancements.

Relinking an executable without recompiling means using the original object code with the cbllink
utility. Original object code is typically the binary file output (usually containing the .obj extension)
produced during the original compilation process. An application can contain one or more binary files.

File Handling
Back to the list

« In some cases the ESF LDAP Security Administration Web Interface inadvertently removed users from
groups when changing their password. This has been fixed.

3124294 (1111259)

e The ESF LDAP Security Administration Web Interface can now filter by Class and Resource name,
description, and ACL. Previously, you could only filter on Class name.

2871549 (1106119)

» Setting the configuration option ASCIISOSI=ON will adds the required SOSI characters to the relevant
EBCDIC DBCS character strings, in order for them to be displayed or written out correctly.

3113802 (1110183)
* The OPEN mode of SYSOUT files now honors the DISP specified in the JCL.

3109432 (1109745)
« OPEN I-O of a virgin ESDS file now correctly returns a file status of 35, as it does on the mainframe.

2887724 (1108443)

IDE
Back to the list

* New functionality to support the debugging of CICS channels and containers has been added to this
release.

2810448 (1098047)

Interface Mapping Toolkit
Back to the list

« Refresh Resources functionality has been added to regenerate existing service interfaces for COBOL
programs whose linkage section has been updated after the service interface was initially created.

2849403 (1103036)

* Due to changes made to the Configure Runtime Environment dialog box in this release, after you
upgrade your system, you must reenter all previously set values on this dialog box before running a
service.

MF Server Administrator (GUI)
Back to the list

* The total number of active sessions or clients in MFDS is now limited to 2000.
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Micro Focus Directory Server
Back to the list

« The mfds -g options D, O, and S have been added to the product Help.

2848627 (1102864)

e On UNIX, specifying an invalid user ID in the MFDS "General" options value for "Default process user
ID" no longer causes the child process (such as a region start or stop request launched from the Web
interface) to fail. The user ID under which the MFDS process was started will be used instead.

« MFDS now disables and limits the scope of Web listeners on add. It also emits a warning if any
insecure Web listeners are displayed in the validate and listener tables.

Run-Time System
Back to the list

e The run-time system now produces a more precise error message if a shared object of the wrong bitism
is loaded.

e scan64 is no longer available. This has been superseded by the COBOL Analysis functionality in the
IDE.
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Known Issues

Known Issues

Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:

e Commuter licenses
» Debugging

« Eclipse

« Enterprise Server

e imtkmake

e Installation

e OpenSSL

Commuter licenses

If there are a number of entries displayed in the License Administration tool, these might be either for
different products or for the same product but for different serial numbers, for example.

When a commute request is made using the license manager, that request is serviced from a pool of
licenses that could be provided by any number of Micro Focus product licenses stored on that server. The
commute request cannot target a particular RMS license by product name, serial number, or number of
cores.

The products to which you apply the commuter licenses will be licensed correctly but the number of
licenses left in the License Administration tool might appear to be less than expected. This issue is more
likely to occur with multiple entries for the same product.

If you are using a number of different products, Micro Focus recommends that you use a different licensing
server for each product in order to help minimize the issue.

Debugging

e core_on_error=3 does not work correctly on AIX 7.2.

Eclipse

On Windows, you might experience some an issue with starting Eclipse where Java Tooling fails to
initialize. These are a result of a known issue with JINA and installing certain Windows updates. To work
around this issue, you need to:

1. 1. Locate the eclipse.ini file in the Enterprise Developer installation folder for Eclipse - C:\Users
\Public\Micro Focus\Visual COBOL\eclipse, by default.

2. 2. Add the following line at the end of the file:
-Djna.library.path=C:/Windows/System32/

Enterprise Server

e On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to O.



imtkmake

e On AIX V7.2, you must install IBM's patch APAR 1304075 in order for imtkmake -genclient to work
correctly. See http://www.microfocus.com/docs/links.asp?vc=IBM_APAR_1J04075 for details about how
to install the patch.

Installation

« Installing this product fails if Micro Focus License Manager version 10000.2.02070 (April 2015) or older
is already installed on your machine. The setup files does not upgrade the License Manager
automatically to the latest version. You must uninstall the existing version before you start the
installation.

OpenSSL

The version of OpenSSL included in Visual COBOL and Visual COBOL 4.0 is intolerant of expired X.509
certificates in the CA Root Certificate collection in some circumstances. Specifically, if you configure a PEM
file that contains multiple certificates as the collection of trusted CA certificates, and one or more of the
certificates in that file have expired, OpenSSL might not be able to load and use other certificates in the file
which are still valid. This can cause certificate validation errors and connection failures for SSL and TLS
connections.

To work around this, you need to remove any expired certificates from such collections. If necessary,
replaced them with any valid certificates that have the same Distinguished Name and Modulus (key). This
is a known issue with OpenSSL. Micro Focus is investigating for other possible workarounds.

Known Issues
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Resolved Issues

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

« Adis

» Application Workflow Modeller
« COBSQL

e Code Coverage

e Codeset Support

e Common Communications Interface
e Compiler

» Data Tools

» Database Connectors

- DB2

« Debugging

» Documentation

« EJB Generation

« Enterprise Server

« File Handling

« IDE

* Interface Mapping Toolkit

* J2EE Connector

« Java Support for COBOL

«  MF Common Client

* Micro Focus Directory Server
« Micro Focus Cryptographic Library
* OLE Class Library

e OO Base Class Library

¢ Run-Time System

¢ Setup Issues

e SQL: HCO for SQL Server

e SQL: MBDT Utilities

¢ SQL: OpenESQL

XML Support

e Zz/Server

Adis
Back to the list

¢ When running under DIALECT"RM", a DISPLAY statement using the WINDOW-CREATE clause will
create a window. Its position can be relative to the parent window or the screen. The position specified
will be the upper-left position of the first character in the window. If the window has a border specified,
the border will not change the location of the first character on the window.

3143230 (1112975)

e By default, the ZERO-FILL SCREEN SECTION clause only affects alphanumeric items when the data is
modified in an ACCEPT statement. For compatibility with ACUCOBOL-GT, Adis includes a new
selection (#3) to the option '16 Force Field to be updated if it is not altered’; it reads: 3: Alphanumeric
fields with the ZERO-FILL clause are updated even if the field is not altered.

Resolved Issues



3137641 (1112412)
JUST (and RIGHT-JUSTIFY) now works when specified in the data item for a CONTROL clause.

3137065 (1112350)
Internal limits that would cause a 'COBCH1990-S Internal error - Code generation of SCREEN
SECTION exceeded 65535 bytes for large SCREEN SECTION' message have been removed.

3130462 (1112572)

Box line characters no longer disappear when using DISPLAY WINDOW BOXED and the background
contains DBCS characters.

3125337 (1111261)
The window1 preprocessor now correctly handles underscores specified as part of a data item.

3123437 (1111084)

When using the Window1 preprocessor to support DISPLAY WINDOW ACUCOBOL-GT syntax, Keisen
and reverse-video attributes are now supported. Note: Due to the way that the attribute system works
on a Japanese OS, to make space for Keisen attributes, background-color attributes are not supported.

3123217 (1111064)

To emulate RM/COBOL behavior, an additional action affecting the left- and right-cursor keys within a
field has been added to ADISCTRL. Setting 25 contains a new action (value #3) that emulates the
behavior of generating an exception when trying to move beyond the left- or right-hand edge of an entry
field. However, unlike RM/COBOL, where you can control the exception generation of the left and right
cursor keys individually and specify the exception values generated, this action affects both keys, and
the values generated are fixed. They are 3 for the left arrow key, and 4 for right arrow key.

3115797 (1110548)
The PROMPT identifier in a SCREEN SECTION now works as expected.

3115743 (1110380)

Application Workflow Modeller

Back to the list

Switching to the Team Developer perspective shortly after starting Eclipse no longer causes the
workbench to freeze.

3142841 (1112929)
AWM elements with disabled "Get Children" action did not have a "Refresh" action. This is now fixed.

3141093 (1112753)

Improved background parser performance in AWM edit sessions with local/network SYSLIB/PROCLIB
paths only.

3132682 (1111976)

Modeled AWM dialogs containing tables enabled multi-selections despite the Ul_MultiSelection attribute
being set to false. This has been fixed.

3130384 (1111742)

Performance has been improved when using local or network paths in SYSLIB for downloading include
files or copybooks.

3128741 (1111573)
If a COBOL copybook or PL/I include file is opened from the breadcrumbs view of a program which was
edited from the Application Explorer or Table Results view, it is now opened in read-only mode.

3126540 (1111789)
If a Get All Properties action in an AWM model is set to execute before opening the context menu, then
the Get All Properties action is now executed before the visible condition of other actions are evaluated.

3123463 (1111136)

Resolved Issues
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* On occasion the properties view failed to refresh. This has now been fixed.

3114864 (1110298)

e Finished mainframe Jobs submitted by AWM tools now display a popup notification message at the
bottom right corner instead of a dialog box. It contains links to jump to the finished job (Jobs view) or
execute its "Job After Action". Its display time can be configured via the MVS function package in AWM
models.

3113130 (1110146)

« The AWM tool "Execute ISPF Edit Macro" provided in the ISPF function package now supports local
edit scenarios in addition to the current remote edit scenario.

3110798 (1110049)

« The new complex attribute "Table Row Selection" has been added to the AWM function package tool
"Open Modeled Dialog". This attribute enables you to define conditions under which table entries are
pre-selected in a table contained in a dialog box.

3108314 (1109771)

* A new string attribute "Custom Error Message" has been added to the model object "Action Descriptor".
If an exception occurs during execution of the action and this attribute is set, its value will be displayed
in an error dialog.

3108004 (1111100)

< The "Get All Properties" attribute of an element type has been replaced with a relationship from an
element type with a Get_All_Properties action which enables more flexibility when specifying the
Get_All_Properties action. For example, you can specify at which point in time the Get_All_Properties
action is executed and how often it is executed for. You can also set enabling conditions for the
Get_All_Properties action so that the action is only executed under specific conditions.

3106896 (1109482)

* The new attribute "Cache Elements" application option has been added. It specifies whether AWM
elements, elements lists, and column configurations for element lists are cached during application
runtime or not. The default value is true.

3106893 (1109481)
e It was not possible to define modeled AWM action labels containing slash characters, since they were
used to define sub-menus. You can now use two forward slash characters (/).

* It was not possible to use AWM file descriptor names as mass processing input parameters for modeled
ISPF function package tools. This is now fixed.

* AWM edit macros failed if temporary work files were missing on the mainframe. This has now been
fixed.

» Property references are now resolved in AWM validate messages.

« A new tool, "Check File Existence", has been added to the "OS - Operating System" function package.
The tool checks if a given file exists in the local OS file system.

» Previously, the Save action was executes twice when an IDz mainframe connection was used during a
remote edit.

3143538 (1112982)

« Double-clicking a partitioned data set in the MVS Explorer now expands it in the Remote Systems view,
or shows its members in the Remote System Details view.

3140345 (1112689)
« The PL/I include file editor could display incorrect error annotations if a PL/I program containing errors
was opened using the Team Developer view. This has been fixed.

3128339 (1111521)

e The Get All Properties action “Refresh” of an AWM model is no longer displayed in the context menu if
the execution point is set to "Before context menu" and the execution rate is set to "Always".

3123339 (1111099)
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« Anissue was encountered when a local and remote path were specified in the PROCLIB attribute in an
AWM model. This has been fixed.

3120804 (1110874)

e PL/l includes are now respected in AWM remote edit scenarios whether they are stored with or without
a file extension in the local cache.

3120778 (1110873)

* When the calendar widget is opened from a modeled AWM dialog that contains a date field, it now
displays the entered date by default, instead of the current date.

3139530 (1112659)
» The description attribute of the AWM function package tool "Open Modeled Dialog" supports multiline
input.

3133829 (1112083)
« The AWM model conditions "Equals" and "Equals Not" could return unexpected results when
referenced property values were undefined. This has been fixed.

3129580 (1111672)

« The AWM action descriptor attribute "Refresh List" did not always refresh element lists in the Table
Results view. This is now fixed.

3129398 (1111649)
« AWM models now validate if a key sequence has been defined more than once for the same key
binding context.

3129063 (1111599)
« Properties that have been hidden in the parent elements stay invisible in the child elements.

3129056 (1111627)
« Properties can be defined as application properties. Application properties are accessible within the
execution context of an AWM application.

3123040 (1111057)
* Variable references are now resolved in labels of actions within AWM models.

3122030 (1110994)
» The z/Explorer login dialog box has been improved. Mandatory fields are now clearly marked.

3135347 (1112262)
« A'"TSCORO0149" exception occurred when an existing workspace is used on a different operating
system. This is now fixed.

3126560 (1111553)
< Browsing the same job twice from the JES Explorer no longer results in an exception.

3121818 (1110948)

COBSQL
Back to the list

e A problem that caused COBSQL to mishandle EBCDIC conversion when the program was called more
than once has been fixed.

3145943 (1113226)

« A problem that caused incorrect indentations in generated code when using the KEEPCOMP directive
has been fixed.

3144736 (1113124)

« A problem with COBSQL handling of spaces between the colon and the host variable name has been
fixed.

Resolved Issues
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3144632 (1113283)
A problem with COBSQL incorrectly handling the AMODE directive has been fixed.

3144632 (1113257)
COBSQL now correctly handles host variables with the same name that are defined in different groups.

3139017 (1112553)
KEEPCOMP will now check SQLCODE for FETCH statements before performing a byte order swap on
COMP data items.

3138321 (1112476)
A problem with COBSQL correctly handling replaced lines greater than 72 characters in length has
been fixed.

3127369 (1111465)

COBSQL failed to recognize declared host variables that were identified using a two-part name. This
has been fixed.

3127102 (1111417)

A problem that caused the COBSQL preprocessor to incorrectly handle the WORKING-STORAGE
SECTION statement has been fixed.

3124957 (1111232)

An occasional problem with COBSQL reinitialization that caused the second background parse to fail
has been fixed.

3124170 (1111154)
The COBSQL preprocessor was not handling COPY... REPLACING... statements correctly, causing the
Debugger to display incorrect information. This has been fixed.

3123903 (1111140)
A problem that caused COBSQL to fail to parse the PROCEDURE DIVISION statement correctly when
part of the statement was in a copybook has been fixed.

3122593 (1111019)
A problem that caused the COBSQL preprocessor to fail to generate HSF trace data When either the
EBCDIC or KEEPCOMP option was specified has been fixed.

3120860 (1110883)
A problem that prevented COBSQL from processing more than 150 lines of similar source code in a
single source file has been fixed.

3112520 (1110134)
A problem that caused the COBSQL preprocessor to incorrectly process child items when either the
KEEPCOMP or EBCDIC options were specified has been fixed.

3110932 (1110772)
A problem that prevented the COBSQL preprocessor to correctly process data groups when the
KEEPCOMP directive was specified has been fixed.

3110932 (1110575)
A problem that caused COBSQL to fail to recognize all data items correctly when the host variable was
a group item has been fixed.

3110932 (1110650)

A problem that prevented COBSQL from correctly recognizing the parents of some data items when the
KEEPCOMP directive was specified has been fixed.

3110932 (1110495)

Code Coverage

Back to the list

Resolved Issues



Correct results are now displayed when you generate a report on a program that is part of a shared
object.

3108051 (1109995)
TCULil will now run correctly without KSH installed.

Codeset Support

Back to the list

The current Shift-JIS EBCDIC to ASCII support under MFCODESET=81,930,939, and 9122 is based
on the Japanese International Standard (JIS) X 0208 1978 revision. New conversion tables have been
added based on the JIS X 0208 1990 revision - the tables have been taken from IBM's Conversion
Tables CCSID 300 - 941. To use these new conversions instead of the default ones, set
MFCODESET _DBCS=941.

3143604 (1112980)

Common Communications Interface
Back to the list

An intermittent failure to establish a TCP connection with various components (including CCITCPR,
COBOL service deployment, and JCL job submission) was caused by the EADDRINUSE error. This has
been fixed.

3123202 (1111222)

Compiler

Back to the list

The 'cobol' command line tool now produces the correct type of output when a 'dll' file is specified using
lowercase; for example: cobol b.cbl,b.dll; Previously, specifying 'DLL" worked as expected, but 'dIl'
produced an executable file.

3147888 (1113355)

An error when adding a literal or unsigned-display-item to an unsigned-display-item, where the receiving
item contains SPACES or LOW-VALUES, and the SIGN-FIXUP directive is in effect, has been fixed.

3133590 (1112121)

For .gnt compiled file types on Intel x86 32-bit only, when call-convention 2 (called program clears stack
- also known as Windows stdcall) and call-convention 8 (litlink) are both in effect, call-convention 8 is
suppressed. This behavior can be turned off by setting the GNTLITLINKSTD directive. This directive
has no effect on other platforms.

3132861 (1111990)
A bug moving a numeric literal to a national alphanumeric variable has been fixed.

3130652 (1111946)
On AIX platforms, a fatal error at generate time for the INITIALIZE statement has been fixed.

3122819 (1111093)
A fatal error at generate time has been fixed.

3122718 (1111075)

A bug whilst stepping through the EVALUATE statement in the debugger has been fixed.

(390 generated code only) An issue that occurred when variable length items used in an IF statement
followed by a MOVE statement has been fixed.

On Linux 390, a program that contains nested programs and is compiled with the OPT Compiler
directive could fail when run with a Run-Time System error 115, "Unexpected signal”.

Resolved Issues
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* An issue where compiling some large programs to 64-bit generated code on Windows led to an
EXCEPTION_STACK_OVERFLOW has been fixed.

« In 64-bit generated code, a call of the form: call "prog" using by value -1 would not sign-extend the by
value parameter correctly. Thus, if the receiving program was of the form: linkage section. 01 p0O pic
s9(18) comp-5. procedure division using by value p0. then pO would receive an incorrect value.

« The presence of a hyphen character in a copybook name is no longer flagged under a mainframe
dialect if located in the portion truncated by the TRUNCCOPY directive.

3150945 (1113635)

e Certain ACUCOBOL-GT format ACCEPT statements, such as ACCEPT ... FROM SYSTEM-INFO and
ACCEPT ... FROM INPUT STATUS, no longer cause unexpected run-time errors. (They continue to be
flagged as unsupported, and now have no run-time effect.)

3145581 (1113165)
* Inthe IDE, when switching between different programs that use the CONSTANT Compiler directive,
background parses now complete cleanly, as expected, and do not crash.

3144957 (1113156)
e OO inheritance involving data with non-ASCII characters now compiles and executes as expected.

3143962 (1113013)
« An OPEN EXTEND statement referencing a sequential file with a LINAGE clause no longer produces a
spurious warning message.

3141789 (1112810)

« Integer-1 for the LINE clause or the COLUMN clause (of the SCREEN section) must be an unsigned
integer, greater than zero and less than 256. However, this value is also restricted by the physical limits
of the screen. If you enter a value greater than 256, you receive a COBCHO0027 error.

3140501 (1112691)
* An INITIALIZE statement whose target is subscripted and contains one or more object references now
produces correct object code.

3138563 (1112509)
« An ILREF directive that contains non-ascii characters is now processed as expected.

3137227 (1112362)
* When the run-time system detects that external files have inconsistent declarations, it now reports the
internal file-name of the file in question, and where possible, reports the inconsistency.

3133860 (1112467)
e Compiler output associated with the XREF option now shows correctly for NATIONAL types.

3131449 (1111836)
« A COPY REPLACING statement that has parenthesis in the replacement text, and is compiled with the
COBSQL preprocessor with CP enabled, now compiles as expected.

3131355 (1111897)

< A bug has been fixed in programs that contain both XML PARSE and XML GENERATE statements, and
the last such statement is XML GENERATE.

3130455 (1111752)

« Passing an intrinsic function as a parameter in a standard INVOKE statement, where the target method
interface defines the parameter as BY REFERENCE, now compiles and executes correctly, as long as
the INVOKE correctly specifies 'BY CONTENT' and is compiled with the REPOSITORY"CHECKING
ON" Compiler option.

3129593 (1111645)

e Support has been added for a new directive DISPSIGN, which emulates the IBM mainframe option of
the same name. It controls the display output of included signs for numeric items, and only affects
output when an IBM mainframe dialect has been specified.
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3127646 (1111445)
Implicitly declared assign names in a program compiled with the REENTRANT"2" directive are now
processed as expected.

3126919 (1111383)
The COBOL Copy View now correctly shows copy contents for remote projects that use the CP
preprocessor and a mainframe dialect.

3125362 (1111326)
The FDCLEAR directive now works as expected for a WRITE statement with an INVALID KEY clause
that contains statements referencing other files.

3124343 (1111171)
The 'window1' preprocessor now respects the setting of the MFCOMMENT directive.

3123999 (1111149)
A tooltip query of an item defined in a method and whose parent shares a name with another unrelated
item in a different method now works as expected.

3123598 (1111113)

An INITIALIZE statement with FASTINIT enabled (which is the default) should not affect table contents if
no portion of the table is explicitly assigned a value by the statement (strictly speaking the content is
documented as undefined).

3123417 (1111098)
A program compiled with FOLDCALLNAME"LOWER", which contains a CALL to a nested program,
now executes as expected.

3123260 (1111085)
A DISPLAY of a signed usage display numeric field that contains non-numeric data now better emulates
mainframe behaviour when under a mainframe dialect.

3121234 (1111025)

A national data item with an associated 88 level that uses the THRU phrase and references
alphanumeric literals (rather than national literals), is now processed as expected, for better mainframe
emulation (that is, the literals are treated implicitly as national literals).

3119944 (1110838)
A program with an EXEC CICS statement that references the address of a linkage item no longer
receives a spurious warning message about the item not having addressability.

3119004 (1110648)
A 'Determine Directives' request for an Eclipse remote project now functions as expected, and does not
crash.

3119003 (1111177)
Inherited object storage from the OO class library now gives correct results.

3117353 (1110502)
The 'headers' preprocessor now functions as expected during a background parse.

3115971 (1110871)
Under the Enterprise COBOL dialect, the limit for the size of a record in a sort file description has been
increased to 32767; this is to reflect the limit on the mainframe.

3115808 (1110443)

The SSRANGE Compiler directive no longer causes an erroneous out-of-bounds error for a reference-
modified variable length group specified as a target item and where the occurs depending on field is
located within the group.

3113495 (1110154)
When using Quick Browse, the various counts around comment lines no longer grows between
background parses.

Resolved Issues
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3112271 (1110046)

* A non-ANSI abbreviated condition that compiled in older products now similarly compiles and executes
(for backward compatibility) in this product.

3109284 (1109737)
» Using the PROFILE directive with a nested program no longer causes a Compiler error.

3108308 (1109633)

e Compiling a program containing ENTRY statements with an SQL ECM no longer produces a spurious
warning about code being unreachable.

2991017 (1108767)

« The MOVE-LEN-CHECK directive now verifies MOVE statements with reference modified operands that
have literal lengths.

2988987 (1110162)

« Compilation using the CP preprocessor, where one or more source files are located on the mainframe,
now works as expected.

2886117 (1109429)

« A DISPLAY of a large amount of data in a program compiled with the OUTDD directive now produces a
SYSOUT file with all data included without truncation.

2885153 (1108021)
« A DISPLAY statement with a very large number of operands now compiles as expected.

2882748 (1107771)

» The correct source location is now reported for the FLAGSTD format error message associated with
code being in the wrong area of source.

2880234 (1107348)
e A SCREEN section declaration with FOREGROUND-COLOUR and HIGHLIGHT clauses now compiles
as expected.

2873489 (1106450)

e Siemens BS2000 COBOL support now extends to the BASED clause and the BYTE-LENGTH intrinsic
function.

2855428 (1103760)

« A new toggle option has been added to the OOCTRL directive, to allow the choice of whether .ins
and .cls inheritance files have directory location comments. OOCTRL(-L) now turns the comments off.

2853073 (1103758)

e An ON EXCEPTION clause on a CHAIN or CALL PROGRAM statement now works as expected, and
does not cause bad stepping behavior while debugging.

2852872 (1110615)

« A SORT or MERGE statement where the maximum size of an input record is larger than the sort
description, or the maximum size of an output record is smaller than the sort description, is now flagged
with an E-level Compiler message.

2826647 (1100193)
< Using an intrinsic function as a parameter to an inline method invoke now works as expected.

* Aninline method now works as a parameter to an inline method. Using the workaround of making the
parameter an arithmetic expression (for example, by adding "+ 0") is no longer required.

* The Compiler directive ACUSYNC now appears in the SETTINGS output, as expected.

* An INITIALIZE statement acting on a property no longer produces a system error or non-functioning
code.

3148897 (1113470)
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When ILDYNCALL was specified, calls to CBL_methods in the run-time system were resulting in errors
occurring at run time. We now attempt bind to such methods statically, even when ILDYNCALL is on.

3125530 (1111313)
When compiling for JVM COBOL, the IS INITIAL phrase of PROGRAM-ID is how working correctly for
programs compiled with DEFAULTBYTE(O).

3122824 (1111844)

When fields defined as pic 9(8)v9(2) (or similar) were exposed using the ILSMARTLINKAGE directive,
setting a field to a numeric value in an external program resulted in an incorrect decimal alignment,
effectively multiplying the result by 10000. This has now been resolved.

3121569 (1110958)
The ILNAMESPACE directive now has no effect on types which specify a namespace name explicitly in
the source code.

(633923)

Data Tools

Back to the list

The /d parameter of the DFSTRCL command line utility is no longer case sensitive.
2989512 (1108654)
Applying a filter to a data file after selecting a field no longer causes the editor to crash.

3139552 (1112637)
Large structure files can now be loaded within the editor.

3122802 (1111101)

When performing a filter more than once, the filter no longer encounters a 9/41 corrupt indexed file, and
the correct navigation buttons are enabled. Additionally, the filter now shows the correct number of
filtered records.

2883777 (1110293)

The Data File editor now enables you to export filtered results to a new data file: option Search>Export
Results when a filter is in effect.

2878521 (1107103)
DFCONV now shows its version number, rather than "TEST", when used from the command line.

3114824 (1110281)

Classic Data File Tools now supports IDXFORMAT(12). You can create files of this format, and use the
Data File Convert tool and DFCONV command line utility (including .pro files) to convert to and from
this format.

3113772 (1110180)

Debugging

Back to the list

Debugging programs compiled with AMODE(31) can now use the pointer values in the memory view.
2878608 (1107108)

When debugging a process that has a mix of debuggable and non-debuggable COBOL code, there is
now no overhead introduced by the debugger when running the non-debuggable code.

3149936 (1113589)
Multi-threaded core file debugging is now supported on Linux platforms.

3136556 (1112739)

Resolved Issues
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Performance when animating a .so program with a large code block, using Visual COBOL on AlX, has
now been improved.

3124951 (1111243)
Animating a core file no longer fails with the message "Invalid coredump file" when the executable, for
the process that produced the core file, is found via a location on the PATH environment variable.

3123453 (1111160)

When using character-mode Animator to animate a COBOL program that uses Database Connectors, if
you exit Animator using Esc, then Y, the Animator process no longer hangs.

3119573 (1111001)
When debugging Intel x86-32bit native OO COBOL code, the stack trace displayed by the debugger
should now show accurate information.

3117359 (1110508)

When debugging a threaded program, breakpoints no longer cause erratic behavior if multiple debug
events are hit simultaneously.

During animation on SUSE Linux Enterprise Server (SLES) 12, if the process being debugged was
waiting in a system-call and you attempted to exit the debug session, the session would have been
terminated rather that executing a 'stop run' in the debugger. This was due to a change in the operating
system between versions 11 and 12, which has now been corrected so that a 'stop run' is now correctly
executed.

With reverse debugging enabled, when you reverse-step/zoom to a location and then query a data item,
it now works as expected.

Previously, pausing a process that is being debugged, and then setting a breakpoint before resuming
may have failed to set the breakpoint if the process was in a long-running system call. This has now
been resolved.

For Linux debug sessions with reverse-debug capabilities, if you are stepping back through code and try
to quit the debug session, the process will no longer sometimes hang.

When using the Character Animator, the detach option no longer hangs the process, terminating it
correctly instead.

3124348 (1111182)

When exiting the Perform View window in Animator, when there is no COBOL execution position,
Animator now continues to debug.

3149539 (1113497)
Changing the values of large data-items in Character Animator now works as expected.

3107393 (1109744)
When using Character Animator, the behavior of program breakpoints can now be configure using the
PROGBPALLENTRY directive.

2849211 (1104729)

Database Connectors

Back to the list

Resolved Issues

A correct XFD is now produced when using the $SET CREATEXFD Compiler directive and the COBOL
code contains a Report section.

3107863 (1109681)

An internal error involving moving XML data has been corrected in File Handler used by Database
Connectors. This error caused an issue involving XML-format XFD files when using the Oracle
Database Connector in certain circumstances.

3120238 (1110790)



Documentation

Back to the list

The documentation now states that the ILSMARTLINKAGE directive is only for use with procedural
COBOL programs, not COBOL classes.

3147500 (1113420)

The product help now clarifies that cblcored.exe requires write permission to the current user’s
HKEY_CURRENT_USER key in the Windows registry. This ensures that any changes to the Core
Dump settings made with the utility will persist.

3142772 (1112972)

The IMS Tracing Flags topic has been updated to accurately reflect the options available in Enterprise
Server.

3142342 (1113320)

An important distinction has been made in the documentation, in that the content of nonnumeric literals,
comment lines, comment entries and data can include any of the 'printable' characters available in the
current character encoding scheme. See the 'Character Set' topic of the Language Reference Manual
for more information.

3140851 (1112720)

The 'Standard File Header' topic now states that the definition is not applicable to certain indexed file
formats. The definition of the node sizes, as specified in the 'Index File - File Header' topic, has also
been clarified so that it applies to all applicable MF index file formats.

3140352 (1112840)

The ACCEPT statement documentation now contains the possible values codes/definitions returned for
EXCEPTION STATUS.

3138691 (1112556)
The documentation now documents the difference between MF COBOL and RM/COBOL when
inspecting the EXCEPTION STATUS in an ACCEPT statement.

3138691 (1112555)

Documentation for the SPZERO Compiler directive now directs you towards the preferred replacement,
SIGN-FIXUP.

3135675 (1112227)

The order in which the File Handler searches for the File Handling configuration file has been correctly
documented for UNIX and Windows platforms.

3132391 (1111933)
The OO COBOL Class Library Reference file, nxrclr.chm, is now provided with the installation of Visual
COBOL for Eclipse (Windows).

3130297 (1111697)

The use of the INTLEVEL Compiler directive has been clarified in the documentation; that is, it is an
internal directive, not intended for customer use.

3129661 (1112191)
If mnemonic-name is associated with ENVIRONMENT-NAME in an ACCEPT or DISPLAY statement, its
value must not exceed 255 bytes.

3126506 (1111354)

A restriction has been documented for the X"B0" Function 2 library routine, where console applications
cannot distinguish between the left and right Shift key presses.

3125717 (1111316)
The documented example for OO switches has been updated to remove an obsolete switch.

3117356 (1110506)
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* A new syntax rule (#9) has been added to the CALL statement topic in the Language Reference
Manual, stating the restriction of passing a floating point item BY VALUE in native COBOL.

3115091 (1110326)

« The documentation for the BELL directive has been corrected to state that it is checked during the
syntax checking phase, and not at the generate phase.

3110088 (1109799)

« In the documentation, the steps required to customize ASCINEBCDIC character set conversion have
been clarified.

3108884 (1109682)

< More information has been added for file and project level problem error markers. See Maximum
Number of Problem Error Markers for more information.

2881233 (1107671)

« An error has been corrected in the description of the "Go To Procedure Division" option in the "Making
the Most Out of The COBOL Editor" topic.

2877216 (1106910)

« Documentation for 'COBRT181 Invalid parameter error' has been expanded to include a possible cause
and solution for the error.

2876095 (1106782)

* The instructions on how to install Fileshare as a Windows service have been clarified - see
'‘Walkthrough - Fileshare as a Service' in the product docs.

2876085 (1106746)

* The product help now clarifies that adding the Micro Focus Runtime (Interop RuntimeServices)
assembly adds the MicroFocus.COBOL.RuntimeServices reference to a Visual Studio project.

2850791 (1103124)

« The Sharing Database Connections Between Java and COBOL topic has been updated with an
example showing object sharing with other languages both when Java opens the connection and when
COBOL opens the connection.

2674454 (1091949)

« The ANSI92ENTRY topic has been updated to include OpenESQL behavior in corfomance with the
ANSI-92 standard.

2596163 (1086171)
« The SQLCODE Values topic has been updated to reflect the most current information available.

2593799 (1085947)
* When compiling tests on UNIX, you should include the -U COB flag.

* The Running Unit Tests in the IDE tutorial for Eclipse now instructs you to create the environment
variable that locates the required data file before the run configuration is created, which how means that
the run configuration correctly uses the variable to successfully run the unit tests.

* The error message description for COBCH1558 has been expanded to include the possible scenario of
when a difference in bitism (between Java version and compilation mode) has caused the error.

« The COBCH1006 error message text has been corrected to encompass the fact that different dialects
have different limits for the length of a COBOL word.

« The documentation has been corrected to state that the LINKLIB directive is not required by the cobol
command. (LINKLIB was an old directive that should no longer be used.)

« The Codecomp Utility documentation now states that you can only create customized tables for single-
byte character sets.

e Anincorrect reference to SYSREC has been removed from the example in the topic "SQLTP2 Utility -
Executing Dynamic SQL Statements".

3145877 (1113167)
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When using the MVSSPLHK spool housekeeping process to override the retain period of a class; for
example: CLASS A 003 Y this refers to the output dataset class, and not the job class.

3138584 (1112576)

The instructions on running the SPOOL conversion tool (splconv) have been updated with
recommendations for setting the MFSYSCAT_ERRS variable. This is because there are a number of
errors generated whilst running the conversion that can be safely ignored, and setting this variable to a
sufficient value will allow the conversion to complete successfully.

3124350 (1111280)
Documentation for MFISABCODE has been added to the Sort environment variables.

When running the dfconv command line utility, the (optional) -d option must be the first parameter
specified in order to have an effect.

3135598 (1112570)

The product help about "Datetime Literals in SQL Statements” now correctly states that to enable the
functionality, you need to code any of the specified SQL comments into your DB2 mainframe
application, positioned before a literal declaration.

3133502 (1112053)

For Fileshare through Enterprise Server, on UNIX systems, Micro Focus recommends that CCI TCP in
loopback mode is used in preference to CCI Named Pipes (CCINAMPU), because support for
CCINAMPU is deprecated.

3131680 (1111868)

The "UNIX and Linux Installers Issues" topic in the product help included an incorrect parameter, "-
EDadminID=[User ID]". This now correctly states the parameter as "-ESadminID=[User ID]".
3129927 (1111675)

Where appropriate, the SYNCSORT and DFSORT documentation now links directly to the topic that
explains the various field types in use.

3123796 (1111143)

Error message BMSCH1099W has been documented.

3122477 (1111005)

The product Help has been clarified for the versions of Enterprise Developer clients and the versions of
z/Server they can communicate with. See Recommended versions of z/Server for Enterprise Developer
for more information.

3121723 (1110991)
The topic that lists the Compiler directives restricted in Managed COBOL has been brought up to date.

3120358 (1110789)

In the documentation, the entry point/parameter name corrected for the UNIX version of the INITCALL
directive.

3104480 (1109719)

Information on the TCLS Entity has been added to the product documentation. See Resource Classes
for ESMAC and Operator Command Security for more information.

2913474 (1108497)

The documentation now references the es_default_|dap.ldf file, which contains a working example for
using the DATASET resource class.

2860914 (1104513)

EJB Generation
Back to the list

Resolved Issues
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A problem that caused EJB client generation to fail when processing OCCURS arrays has been fixed.
3131411 (1111877)

Enterprise Server

Back to the list
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Starting the MFDS process with the -r option will now disable the Web administration Ul. If using a
browser to connect to the MFDS TCP network address, you now receive an HTTP 403 response.

A missing form name in some Enterprise Server Administration pages could result in a JavaScript error.

The default options under ESMAC > Resources now depend on the Region options. If JES is installed,
the new default resource to show under Resources is JES. If IMS is installed, and JES is not installed,
then IMS is the default. If MQ is installed, and both JES and IMS are not installed, then MQ is the
default. If iFS is installed, and each of JES, IMS, and MQ are not installed, then iFS is the default.
Otherwise, the default resource is Services.

2871166 (1106098)
An issue using single sign-on between MFDS and ESMAC has now been fixed.

3106232 (1109779)

The Enterprise Server External Security Facility (ESF) has improved redundant / failover support for
Security Managers. See "Security Configuration Custom Configuration Information" in the product help
for more information.

2990790 (1109080)

The Enterprise Server External Security Facility's MLDAP ESM Module can now generate an audit
event describing the "effective rule" that determined the decision (allow / deny / permissions set) for an
Auth or XAuth request. The effective rule is the security rule that was used to make the decision. See
“MLDAP ESM Module Custom Configuration Information” in the product documentation for more
information.

2887945 (1110096)

Enterprise Server Security trace message 2003, emitted when a SAFROUTE(Auth) request is made
with the "API trace" flag enabled and access to the resource is denied, no longer truncates long
resource names. Long names are abbreviated but still provide the prefix and suffix of the name.

2885856 (1108682)

Enterprise Server's External Security Facility, when using LDAP-based security, has an "Update"
mechanism that can be used to notify MFDS and running Enterprise Server regions of changes to
security information. This now works correctly for changes to group membership, for example, when a
user is removed from a group.

2873024 (1106452)

Depending on the sequence of login, users with long usernames that contained spaces and that had
usernames similar to other users could login and find that they are treated as if they do not have the
correct user permissions. This has now been fixed.

In Enterprise Server, when using LDAP-based security, if a user belonged to a group with an LDAP
wildcard character (such as "*") in its name, and there were nested groups defined, and the use-all-
groups mode was enabled, groups that contain other groups could be incorrectly added to the user's
group set. This has been fixed.

mfds and casstart will now run successfully on machines with locale names with the @maodifier part,
such as fr_FR.is0885915@euro.

2868439 (1105641)
Extended ECI LUW context is now maintained.
3148577 (1113418)



Using the dump command from an MQ listener resulted in an AB/BA lock.

3146317 (1113217)
In 64-bit environments, ECI requests that do not use ES_ECI_SOCKET to identify or locate the target
region used to fail.

3143232 (1112962)
A request made with valid credentials no longer fails after an initial request that returned an error ECI-
ERR-SECURITY-ERROR.

3142092 (1113220)
The Data File Editor now supports DSNs that contain the '£' and '# characters.

3140182 (1112661)
The casstop /w command no longer creates a ccierr.log when a region terminates during the /w delay.

3135994 (1112257)
Previously, when creating a new DFHDRDAT, the provided users had an invalid phrase setup which
resulted in sign-on errors.

3135433 (1112238)
When a job that performs an EXCI LINK without the SYNCONRETURN option was submitted twice in
succession, the second job did not run successfully.

3129348 (1111596)

previously, HSF records for tasks that executed prior to a switch of the active file could be written to the
newly active file. This has been fixed so that records are written to the file that was active at the time the
task ran.

3125864 (1111322)
An issue with DFHJSON where JSON data would not be written to a container has been resolved.

3121607 (1110917)
The casutl command line utility supports a new option, /x, which enables you to switch the active trace,
dump and/or hsf files. For more details, see your product's documentation.

3120728 (1110848)
When recycling SEPs in a busy JES system, jobs that have not run yet are now managed correctly.

3120670 (1111235)
In a busy system, if JCL jobs timed out or were cancelled, the local trace entries could sometimes
corrupt the shared memory causing the region to become unresponsive.

3116835 (1110501)
Mapping structures to containers in DFHISON when there are consecutive multiple empty elements
now works as expected.

3114815 (1110285)

If the result length from a call to CBL_CCSID_CONVERT was smaller than the original buffer length,
garbage was written at the end of the buffer. This was because the length used was the original length
and not the length returned from the call.

3114365 (1110223)
A FREEMAIN of a shared pointer which had been populated in a SEP other than the one attempting the
free would provoke a trap.

3112416 (1110196)
When either a CPMT NEW COPY is issued or FORCE PHASEIN is enabled on the SIT, MAPs are now
reloaded from the disk and the memory version will not be used.

3105813 (1109891)
System folders that have a backslash at the end of the name are now supported in region
configurations. Previously, a region would fail to start in such scenarios.

Resolved Issues
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2886956 (1108250)
« If there was an error when trying to start cobdebugremote, the port was not retrieved.

2864798 (1105495)
* When defining a GDG model, the path is now grayed out.

2855374 (1103840)
* Itis now possible to use environment variables in MQ Listeners queue names.

2842137 (1102027)

< If a casout -g command to retrieve relative DD for a job was issued and the resulting file had a size of 0,
the file was left open which resulted in a leak of handle.

2814439 (1098608)
* Anissue causing the BlueZone terminal emulator to disconnect has been resolved.

2807210 (1098676)
« Requests are now aborted if the ECI luw token is invalid.

* The "Use all groups" option for a secure enterprise server instance now enables the Data File Editor to
authenticate a user against all of the groups for a particular user.

« Using casout with the /v option (to list initiators, printers and mprs) could cause incorrect HSF records to
be generated.

e You can now use CBL_DEBUG_START and CBL_DEBUG_STOP to generate live recordings on x86
Linux platforms. You can generate consecutive live recordings from a single process, whereas
previously you could only generate one per process.

« Itis now possible to edit the dataset name entry in ESMAC if an incorrect name was submitted when
adding the dataset.

« Imported hexadecimal transactions are not truncated anymore.

3153155 (1113813)
» Fixed an issue with the admin seps terminating abnormally when a USER (who is not associated with a
group in ESM) tries to logon to ESMAC.

3152197 (1113814)

« Access to the XAT resources in ESMAC (casrdo65) is now controlled by the user's security settings for
the 'XAT* resource under MFESMAC. The user will require "Update" access to the GRP resource in
order to see the XAT Delete button.

3143258 (1112991)
« TCPIPSERVICE resources are no longer erased when the URIMAP resource is set to PIPELINE. In
addition, ESMAC now accepts blank WEBSERVICE fields.

3141235 (1112752)
* The deletion of a PDS member in a secure region now use the correct classes.

3140443 (1112709)

e Sometimes the STOP button for connected clients in ESMAC was not displayed when security was on.
This has now been fixed.

3139885 (1112724)
» Date and time filter values are now retained when the jobs are filtered to user requirements in ESMAC.

3138516 (1112498)

* The Reply button for a waiting from console JOB in ESMAC is how enabled or disabled depending on
user authority.

3137426 (1112397)

e The environment variables ES_DISABLE_DFLTUSR_SIGNON/
ES_ESM_DISABLE_DFLTUSER_ESMAC are now correctly honored in secure regions.

3133646 (1112061)
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When specifying the ES_MAX_CATALOG_LINES environment variable, one line fewer were displayed
in the ESMAC catalog view. This has been fixed.

3129034 (1111563)
The 9/041 error no longer occurs when accessing catalog after running a job that accesses the proclib.

3122584 (1111066)
An issue in the date and time filters in the ESMAC spool display page has now been fixed.

3122475 (1111003)
The Job page now displays in Shift JIS encoding if the operating system encoding is determined to be
Shift JIS.

3115107 (1110311)
The SIT 'New' button is no longer greyed out when the ESMAC user has the appropriate permission.

2913474 (1108809)

If the Data File Editor was used to retrieve the DCB information for a data file hosted by Enterprise
Server and the catalog did not contain a physical filename, an RTS 114 error would be encountered.
This has now been fixed.

The PostgreSQL switch module now loads correctly in 64-bit mode.

3149380 (1113516)

A problem recovering from errors where SQL Server unilaterally terminates an XA transaction has been
resolved.

3145058 (1113133)
User Impersonation now works as expected when using an ODBC switch module in batch mode.

3140100 (1112655)

The ESMSSQL switch module no longer returns an RTS153 error if USERP=T is set and the user does
not exist.

3140097 (1112649)

The Oracle switch module no longer fails with an RTS153 error when being enabled after an initial
connection error.

3129198 (1111608)
Auditing using syslog now reconnects correctly after the syslog server restarts.

3135191 (1112186)
Auditing modules are now loadable on all supported platforms.

3124417 (1111183)
Syslog messages can now be configured to use TLS as the transport protocol.

File Handling

Back to the list

Users, Groups, and Classes can once again be searched based on substring matches, rather than full
exact matches.

3127314 (1111414)
Password Expiry and Account Expiry dates are now correctly displayed in the ESF LDAP Security
Administration Web Interface when specifying times in 24 hour format.

2883964 (1107911)

The Users in the "Members" list for Groups and Groups in the "Group Membership" list for Users are no
longer incorrectly filtered by the filter on the respective "Users" and "Groups" main tabs.

2871547 (1106121)
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The ESF LDAP Security Administration Web Interface no longer incorrectly displays a blank Users/
Groups list when changing tabs.

2863056 (1104795)

The REPRO of a cluster that contains an alternate index no longer performs the copy using the
alternate index. It uses the primary index instead.

3136566 (1112386)

When running under a mainframe emulation, if the INDD record length does not match the cataloged
length for SYSIN when performing an ACCEPT statement, and that results in a partial record being
read, that record is now returned (as it does on the mainframe).

3120786 (1111421)

9/41 additional statuses 2, 4, 5 are no longer printed to the log without an associated log entry for the
actual 9/41 error.

3115318 (1110341)

Setting RUNITLOCKDETECT=0OFF no longer causes an unhandled exception when a file is opened
multiple times in managed code.

2885757 (1108212)

File Handler settings supplied by the extfh.cfg configuration file are now captured in CTF tracing of the
File Handler.

2849599 (1102983)

If, in a single process, Fileshare is called with both FCD2 and FCD3, the filename sent to Fileshare no
longer becomes corrupted.

3131960 (1112168)

The reading of keys no longer fails when the indexed file that was open prior to the current file was not
explicitly closed.

3129038 (1111565)
The EXTFH option RETRYOPEN has no effect when set in the Fileshare Server configuration file.

3106992 (1111699)

An SPLJINO filename will no longer become corrupted when being accessed simultaneously through a
Fileshare server currently under load.

3106992 (1112094)

iFileshare no longer hangs during a stop run operation if files being used in the program are accessed
through different iFileshares.

3142333 (1112939)

IDE
Back to the list

Resolved Issues

Content assist will now provide the correct proposals when triggered on the last line of an unclosed
program.

3112349 (1110179)

Content assist was not offered in the COBOL editor on lines with a * in column 1 even when
NOMFCOMMENT was in effect. This is now fixed.

3149311 (1113493)

Deleting text while Smart Edit Mode is enabled will now result in consistent behavior for both insert and
overwrite editing modes.

3144336 (1113053)



The “force capitals" editor preference is now respected when the editor is in block selection mode.

3143629 (1113003)
You now receive a message when the validation fails in the remote debug symbol container dialog box.

3142352 (1113505)
When you pass FailOnError="true" to the PliTask, Ant now requires a return code of <1 for success.

3142124 (1112930)

The startrdoserver script now tidies up temporary files when java is missing from your PATH
environment variable.

3141448 (1112815)
sentence added to dependency path properties page for cobol projects to clarify how copybook
searching will be done

3141380 (1112769)

Blank messages could appear in the Eclipse Error Log when a workspace created with a prior product
was opened using 3.0 and the workspace had saved Micro Focus Directory Server credentials. This has
been fixed.

3137626 (1112428)
Code coverage statistics are now displayed correctly in locales which use a comma as the decimal
separator.

3137142 (1112695)

"The context for copybook has been lost" error messages was displayed when Eclipse restarted when
copybook editors were open using the RSE file system when Eclipse was closed. The projects
containing the files and the editors are now reopened when Eclipse is restarted.

3137122 (1112794)

References to jars used within a project are now referred to using a project relative path in the
project’s .cobolBuild file.

3136382 (1112323)

When directive determination is used on files in a project with SQL preprocessors enabled, files which
do not need the preprocessors for compilation now correctly disable them.

3134406 (1112303)

When a copybook is in a folder that is the target of a linked resource whose target is specified in a
different case to the actual case of the target, the copybook context is now correctly handled - this had
caused the context lost dialog box to be displayed when the copybook was opened from nodes under
the main source in COBOL Explorer.

3131640 (1112554)
Delete and some other functions had not worked when editing copybooks that were located outside a
project, this has now been fixed.

3129768 (1112551)
Remote debugging performance has been improved.

3129761 (1111691)
Directives files located in the project folder were not found when background parsing a program located
in a different folder, this is now fixed.

3129638 (1111667)
Editor background parse performance has been improved when using local or network paths in an
AWM modeled SYSLIB when downloading include files or copybooks.

3128741 (1111572)
The version of Apache Ant used to build projects has been changed to reduce the build duration.

3128609 (1111546)

Resolved Issues

39



« Compiling a single file within the Eclipse IDE could take an excessive amount of time if the workspace
included a large number of linked files. The performance has been improved.

3128124 (1111477)
» Editor opens in read-only mode when the file does not have write access.

3126540 (1111914)
« Syntax highlighting for COBOL comments now correctly respects source format and dialect when an
asterisk appears in the first column of a line.

3126371 (1111355)
« A clash in keybindings between a third party contribution and the 'Start Debugging CICS Transaction'
has resulted in a change in keybinding, from "Alt+Shift+D X" to "Alt+Shift+X Z".

3126233 (1111374)

* Deleting a COBOL program in a COBOL JVM project when "Use Dynamic Calls" is set now deletes the
build artifacts relating to the deleted program in a manner consistent with COBOL projects. The deletion
no longer prevents a full rebuild of the project from being triggering.

3125727 (1111294)
< Error messages in programs processed using the AWM Mainframe Pre-compiler Integration module
could be misaligned if COPY statements were resolved locally rather than on the mainframe.

3125413 (1111462)
* The use of the GNT directive in the file or project’s properties Additional directives field to specify the
name and location of the generated file has been fixed.

3124811 (1111229)
< An editor can now be opened using the Team Developer view while a background parse is still being
performed on the contents of a different editor.

3123481 (1111209)

* You can now search subfolders when you add a Remote File System Directory to the debug symbols
lookup path in the Debug Symbols tab of the Debug Configurations. Note: Debug symbols containers
length must not exceed 32,725 characters.

3123390 (1111082)
« The Quick Browse dialog now provides an option to clear its search history.

3123390 (1111188)

* It was not possible to set breakpoints in a COBOL Copy view when debugging code that had been
compiled without absolute paths outside Eclipse and the build articles had been moved from where they
had been created. This has now been fixed.

3123390 (1111109)
« Rerunning a COBOL Reference search could show 0 results when a background parse error was
shown in the editor. This has now been fixed.

3121316 (1111609)
*  When COBOL programs containing EXEC SQL statements were added to an SQL enabled project the
file setting was incorrectly overridden and disabled. This has been fixed.

3116071 (1110412)

< Inthe COBOL and PL/I editors, Micro Focus annotations can now be navigated to by clicking the Next/
Previous Annotation menu items. Bookmark and 3rd-party error marker annotations now show their
hover text correctly in the COBOL and PL/I editors.

3111182 (1109906)
« Aline break is no longer inserted after a template unless the template pattern specifies it.

3110480 (1109830)
« Fixed an issue with EGit history support for COBOL sources in Eclipse, which was causing an "Editor
could not be initialized" exception.
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3109071 (1109711)

COBOL paragraphs can now be correctly navigated to from the same-program sections which appear
earlier in the source listing than the ones in which they are specified.

3108275 (1110003)

Programs in remote DB2 projects showed an error in the editor. F3 did not open SQL include files
unless the DB2 software was installed on the local computer. The ESQL pre-processor is how used
when Eclipse is performing a background parse of the programs.

3107896 (1109631)

The scope of the declaration referenced by the LIKE declaration is no longer incorrectly processed
which resulted in a background parse error.

3107664 (1109726)
Handling of some LIKE declarations are no longer incorrectly marked as a background parse error.

3107663 (1109584)
BGP of file attributes now accepts INPUT, FB, RECSIZE, and ENV.

3107662 (1109565)
The background parser incorrectly flagged the POSITION attribute as an error. This has been fixed.

3107661 (1109564)
The background parser incorrectly flagged an underscore

3107657 (1109563)
The background parser incorrectly flagged a b4 hex constant as an error. This has been fixed.

3107656 (1109562)

In the PL/I editor, you can now browse to include files which contain a # character in their filename or
path.

3106041 (1109567)

Cursor position is now calculated correctly in the BMS and IMS editors when a line contains double-byte
characters.

2883915 (1107866)

Shift Out characters displayed in the COBOL editor appeared to occupy 2 bytes instead of 1, this is now
fixed.

2882959 (632769)

The following advanced copy/paste functionality is now available in the editor: Use CTRL+SHIFT+C/
CTRL+SHIFT+X or Edit > Copy Lines/Cut Lines to select a range of lines and copy or cut the entire
lines (regardless of whether the highlighted range covers a line in its entirety). To paste text from the
clipboard before the current line, use CTRL+SHIFT+V or Edit > Paste Before Line.

2860785 (1104564)

Filter capability has been added to the COBOL Explorer and PL/I Explorer views.

2856476 (1103924)

BUILD/CLEAN STARTED message in the build console is now accompanied with a matching BUILD/
CLEAN FINISHED message that indicates the end of the task output.

2852872 (1105047)
Using directives files with absolute paths now works correctly in Eclipse.

2852872 (1110901)

The Import Remote Micro Focus Projects wizard now displays projects that cannot be selected as a
greyed out project in the Projects list.

2852872 (1110900)
Long running background parse operations can now be cancelled.

in literals as an error. This has been fixed.
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» DSNs prefixed with '&&' were incorrectly marked as unreferenced in some cases, this has been fixed.

« It was not always possible to enter text between columns 72 and 80 in the COBOL editor when a line
contained DBCS characters. This has now been fixed.

Interface Mapping Toolkit
Back to the list

* A problem that caused memory leaks in JSON-based Web Services has been fixed.
3109465 (1109773)

J2EE Connector
Back to the list

< You no longer receive Java heap errors when a resource adapter is passing large amounts of data.

3120684 (1110892)
e JSP generation works correctly when there are OCCURS fields.

2869932 (1105858)

Java Support for COBOL
Back to the list

« The Javademos Readme files have been updated with new instructions.

MF Communications Server
Back to the list

« Enterprise Server and the Micro Focus Common Client now support opening more than 256 SSL-
enabled endpoints simultaneously. Also, a resource leak in the MFCS process for HTTPS connections
made with CICS Web Interface or CICS Web Services has been fixed.

3137166 (1112477)

< A situation where some terminal emulators were unable to connect to an enterprise server region has
been fixed.
3135166 (1112195)

e The maximum size of an HTTP header value allowed for a CICS Web Interface or CICS Web Services
server can now be configured. Include an [HTTP] section in the configuration information on the Edit
Communications Process page, and use the option 'maximum header value length=<num-of-bytes>'. If
not specified, the default number of bytes is 1024.

3127781 (1111480)
* A bug that caused some clients to crash MFCS when submitting 3-character trancodes has been fixed.

3121264 (1111026)

» Enterprise Server now correctly handles chunked HTTP message bodies. The CRLF sequences, which
appear after each chunk, are now removed when the chunked body is consolidated.

3100279 (1109784)

« The Enterprise Server Communications Process (MFCS) can now restrict access to listeners by client
address. See "Conversation Filtering" in the product Help for more information.

2887418 (1108517)
< Enterprise Server's backward compatibility with older versions of MFDS has been restored.
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MF Directory Server

Back to the list

Automatic corrections are now made to invalid Enterprise Server listener ISC configurations when they
are loaded or imported.

3136730 (1112328)
Regions exported using MFDS now include the IMS query name if present.

3130077 (1111684)
A missing product HTML file could cause the Enterprise Server Administration HTML GUI to revert to
using English text rather than the configured language. This is now fixed.

3118363 (1110595)
A memory leak in the MFDS process which could cause an intermittent crash has been fixed.

2886846 (1108593)

The "mfCASIMSMFSNullChar" and "mfCASIMSTMMQColdStart" IMS region attribute values are now
imported correctly from a previously generated XML export from the Micro Focus Directory Server.

2879665 (1107226)

The "IMS Configuration Directory" configuration value has been deprecated and has been removed
from the Enterprise Server Administration Web Ul for Enterprise Server instance properties.

For additional security, any start, stop or not-responding region scripts region will only be executed if the
Micro Focus Directory Server restricted administration is enabled.

You could get an RTS115 error in MFDS on AIX when performing certain actions such as browsing the
properties of an ESM.

When executing Enterprise Server in a Docker container, you need to set the
MFDS_EXTERNAL_ADDR environment variable to a resolvable external address string (a hostname
rather than an IP address) in the Docker environment. This is to enable client browsers to resolve
ESMAC and other URLs in Enterprise Server Administration. The value of this variable will replace the
internal container address in the URL.

The Enterprise Server Administration Web Ul "Directories” menu item and functionality has been
deprecated and is no longer available.

If MFCS control channel is configured to use SSL, MFDS must have an environment variable "MFDS _
$SERVERNAME_CAROOQOT" defined, which points to the full file path of the CA root certificate used to
sign the control channel's certificates.

Micro Focus Cryptographic Library

Back to the list

The MFDS could crash during startup when SSL and a keyfile with no password are used to secure it.
3152964 (1113791)

OLE Class Library
Back to the list

An issue with the tabbing of ActiveX controls has been resolved.
3106202 (1109437)

OO Base Class Library

Back to the list

The SortedCollection class methods setSortMethod and setSortEntry are now thread-safe.
3145921 (1113207)
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The class libraries resources now compile without having to add the Windows SDK include location to
the INCLUDE environment variable.

3117380 (1110512)

Menu item objects are not destroyed until the on idle processing. This is to stop the destroying from
being attempted twice.

3107820 (1110204)

Run-Time System

Back to the list

44 | Resolved Issues

When native COBOL calls a Java method that returns an array of objects, the returned object reference
now correctly represents the array of objects.

3144462 (1113127)

When creating a live recording file, if you specify a path in the COB_LIVE_RECORD environment
variable, the path is now validated (to ensure it exists) before the process runs.

3136927 (629611)

A new tunable has been introduced, dbcs_text_enable_clip, which when set to true ensures that the font
is clipped to the font height supplied by Microsoft Text APIs rather than overwriting pixels beyond the
font height. Use this tunable when running in a GUI window (runw). The default is false.

3136924 (1112338)

The NUMPROC"ACOS" directive has been enhanced to support certain elements of NEC ACOS
COBOL relating to the processing of invalid data in USAGE DISPLAY data items.

3135821 (1112242)

A bug in the NUMPROC"ACOS" emulation of NEC ACOS COBOL has been fixed. The error occurred in
statements of the form: move unsigned-display-item to numeric-edited-item where the source item
contains a negative value.

3135821 (1113569)

The NUMPROC"ACOS" directive has been enhanced to support certain elements of NEC ACOS
COBOL relating to invalid sign information in USAGE COMP-3 data items.

3135820 (1112241)

In the run-time text window, the correct key-code is now returned when the Tab key is pressed after the
Window menu has been previously selected using the Alt + Space shortcut.

3132989 (1111983)

The position and size of windows created with the WINDOW-CREATE clause in Dialect(RM) will no
longer be constrained by the window that was active when the call is made. Previously, a window
created by WINDOW-CREATE would be required to fit within the constraints of the parent window. This
behavior was not consistent with the same command under RM/COBOL, and so was changed.

3131065 (1111843)

A GUI application no longer fails to terminate correctly if the title bar of the text window console is
currently selected with the mouse when the termination occurs.

3124823 (1111218)
OO CTF tracing now correctly outputs the thread-id to file.

3117361 (1110510)

When using .INT code, an arithmetic statement involving a 64-bit COMP-5 operand now gives the
correct results.

3111631 (1109997)

When entering multiple DBCS characters using the IME, the later characters in the string are no longer
being corrupted. Previously, corruption occurred due to a bug in Microsoft's ReadConsolelnput() API.



3111356 (1109909)

A new parameter is available for the CHECKDIV Compiler directive that emulates behavior when
attempting to divide by zero on an ACOS mainframe system. CHECKDIV"ACOS" will result in both the
quotient and the remainder being set to the value of the dividend if a divide by zero operation is
attempted when no ON SIZE ERROR clause is specified.

3111073 (1109890)

The NUMPROC Compiler directive has a new parameter. NUMPROC"ACOS" provides partial
compatibility with the behavior of NEC ACOS COBOL processing of invalid data in USAGE DISPLAY
data items.

3111072 (1109889)

On file systems that support 64-bit inode numbers, CTF output files were not produced in the expected
directory if its inode number was sufficiently large that it did not fit in 32 bits. This has now been
corrected.

3109110 (629772)

When using the COBOL printer routines, the default printer is now selected on Windows Server 2016.
Registry differences introduced with Windows 10/Sever 16 caused existing functions to select the wrong
default printer. These have now been updated to use an alternative method to achieve the correct
result.

3109043 (1110153)

An intermittent runtime error (COBRT255: CODESET cannot open double byte conversion table) could
occur when MFCODESET was set to a value that included double byte conversions. This has been
fixed.

3108885 (1109915)
The correct status-code definitions (for Windows and UNIX) are now recorded in the documentation.

2879887 (1107243)

Improvements have been made to the run-time system, the File Handler and the JCL engine, with
regards to error trapping and reporting.

2867927 (1106202)

Spurious errors no longer occur when compiling or running programs on 32bit Linux platforms with an
XFS file system greater than 1TB.
COBUTFS8 no longer segfaults if COBDIR is not set.

Setup Issues

Back to the list

The DemoCA installer now works correctly on Japanese OS.

3142481 (1112900)

An issue with some empty folders created during installation ad not deleted when the product was
uninstalled has been resolved.

3115392 (1110376)

The RPM installer now displays the correct information about the Install and Update commands at the
end of RPM extract.

3108619 (1109717)

DB2
Back to the list

The DB2 preprocessor sometimes generated a 309 malformed subscript error if the SQL statement
contained COMP host variables with an indicator variable array. This has been fixed.

3142686 (1112952)
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A problem that prevented the use of CBLLINK on compiled programs that use LITLINK has been fixed.
HCO now supplies the LIBs necessary to link these applications. Note: If you compile static DB2
applications that use LITLINK, you must compile them using the DB2(NOPRE) directive, and specify all
applicable LIBs in the LINK statement. For example: CBLLINK SELECT.obj DB2API.LIB,
MFHCOLIB.LIB, MFSQLSMF.LIB

3135847 (1112270)

The DB2 preprocessor incorrectly generated code to convert COMP fields in SQLCA if no SQL
statement was found in the program. This resulted in error "COBCHO0002 Undefined ECM error. Inform
Technical Support. Error code 309". This issue has been resolved.

3129362 (1111619)

The DB2 preprocessor has been enhanced with a new directive option, DB2(STOPROC), that provides
a solution to a problem that prevented DB2 LUW stored procedures from working properly when
compiled with CHARSET(EBDIC) because character information is passed to and from DB2 LUW as
ASCII data.

3129260 (1111614)

A problem that caused the DB2 preprocessor to generate DB103 errors on mainframe-style VARCHAR
host variable definitions has been fixed.

3123813 (1111337)

When run against DB2 LUW version 10 or later, the HCO DCLGEN tool sometimes defined the first
column in a DECLARE TABLE statement incorrectly by dropping WITH DEFAULT. This has been fixed.
3119616 (1110699)

The DB2 preprocessor and HCO runtime have been updated to convert an entire VARCHAR field to

EBCDIC rather than just converting the length of data specified. This corrects a problem with erroneous
ASCII spaces showing up in VARCHAR columns.

3110220 (1109819)

SQL: MBDT Utilities
Back to the list

DSNUTLB LOAD no longer gives an SQL error for columns that are defined as DECIMAL EXTERNAL
and that have a POSITION clause containing only a start position, but no end position.

3139744 (1112632)

A problem when that occurred when querying referential integrity information for a table has been fixed.
In addition, a problem with CompiliOptionBlock being out of sync with new ESQL directives has been
fixed.

3119350 (1111458)

SQL: OpenESQL
Back to the list

Resolved Issues

OpenESQL now supports RETURNING clauses in INSERT, UPDATE and DELETE statements when
using SQL(DBMAN=ADO) and SQL(PROCOB).
3120916 (1110849)

A problem when using an Oracle REF CURSOR in managed code that sometimes caused subsequent
statements to fail has been fixed.

3113118 (1110287)

Problems with DATE and TIMSTAMP handling when using the Oracle fully managed provider for
ADO.NET have been fixed by introducing new environment variables to control .NET formatting of
datetime and datetimeoffset values when DATE=EXTERNAL is set for Oracle connections.

3108444 (1109632)



Problems with DATE and TIMESTAMP handling when using the Oracle fully managed provider for
ADO.NET have been fixed by introducing new environment variables to control .NET formatting of
datetime and datetimeoffset values when DATE=EXTERNAL is set for Oracle connections.

3107838 (1109570)
An issue with singleton selects that have no FROM clause but have a WHERE clause has been fixed.

3151028 (1113711)

A problem that generated an undefined preprocessor error and caused compilation to fail when a literal
of a size greater than 79 characters was used with the SQL LIKE operator has been fixed.

3150466 (1113596)

Previously, when using SELECT... INTO statements containing a FOR UPDATE clause with PostgreSQL
and MySQL, the pseudo column used for positioned updates was not present in tables. A new
OpenESQL directive, SQL(NOWHERECURRENT), is now available. This benefits PostgreSQL and
MySQL applications that do not require positioned update or delete support, and where the pseudo
column used as a rowid to implement positioned updates and deletes is not present.

3146620 (1113335)
A problem using "plan" as an SQL identifier has been fixed.

3146620 (1113251)
An issue with using the SQL(XAID) Compiler directive with IMS applications has been resolved.

3144626 (1113137)
A problem with applications using a very large number of embedded SQL statements has been fixed.

3142107 (1113006)
The file cobmfdsntiar.so is now included in the COBOL Server product.

3132441 (1112164)
The limit for the number of compiled SQL statements has been increased from 5000 to 12000.

3129084 (1111593)

An inconsistency with the OpenESQL ADO.NET runtime handling of PIC X host variables in DBCS
locales has been fixed.

3128324 (1111562)
A problem with EXEC SQL ALLOCATE for SQL-CLOB host variables has been fixed.

3128295 (1111492)

OpenESQL for ADO has been updated to behave consistently with Pro*COBOL by returning a +1403
SQLCODE instead of an erroneous -1403 SQLCODE when a PL/SQL stored procedure fails to handle
a data-not-found condition.

3128289 (1111491)

A problem that prevented the setting of the UNSAFE_NULL directive from the IDE when using
Pro*COBOL has been fixed.

3127696 (1111447)

A problem with Oracle scroll cursors that resulted in a backward compatibility issue with Net Express
has been fixed.

3126245 (1111648)

If you use an AT db_name clause in a DECLARE CURSOR statement, you no longer need this clause
in statements that reference the cursor, such as FETCH, CLOSE, GET NEXT RESULT SET or
positioned UPDATE and positioned DELETE statements. To maintain backward compatibility the clause
may optionally be included, but it is no longer required.

3124001 (1111150)

A problem that caused the OpenESQL preprocessor to generate invalid code when "AT xxxx SELECT"
was specified in an array singleton SELECT statement in managed code has been fixed.

Resolved Issues
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3123827 (1111128)

* A problem with SQL(CHECK) that was introduced in version 3.0 of this product and occurred for DB2,
Oracle, and PostgreSQL with ADO.NET has been fixed.

3121267 (1110919)

» A problem using AT <connectionName> with COMMIT, ROLLBACK, and SAVEPOINT statements has
been fixed.

3115063 (1110308)

e A new SQL compiler directive option, PICXBINDING, has been added to OpenESQL to provide more
intuitive behavior for LIKE expressions with SQL Server by enabling greater control of parameter
binding for PIC X host variables.

3113999 (1110373)

e OpenESQL has been updated to retain the FOR READ ONLY clause when the TARGETDB SQL
compiler directive option is set to DB2.

3112785 (1111030)

« A problem with fractional seconds truncation when using the legacy SQL Server ODBC driver has been
fixed.

3112499 (1110032)
» A problem using SYSTEM_USER in select statements has been fixed.

3111513 (1109934)

e A problem caused by OpenESQL rounding a result to a COMP-3 host variable instead of truncating it
has been fixed in the ODBC runtime.

3110902 (1109871)

« A problem with OpenESQL trimming trailing spaces in input host variables has been fixed by the
addition of the SQL(PIXCBINDING=FIXED) compiler directive option, which ensures that these trailing
spaces remain intact.

3110720 (1110099)

* A problem handling unmapped codepoints in DBCS locales when storing binary data in character fileds
and using SQL(ALLOWNULLCHAR) has been fixed.

3109266 (1109723)

e OpenESQL had a storage limit of 30 characters for a program ID. The maximum has been increased to
128 characters.

2884875 (1107982)

e A problem that caused OpenESQL to remove any OPTIMIZE FOR n ROWS clause from queries when
TARGETDB was set to DB2 has been fixed.

2883301 (1108387)

* A problem with HCOSS access plans getting out of sync with the running code and database stored
procedures and metadata when a live ES region is updated has been fixed.

2877693 (1110926)

e OpenESQL has been updated to support the OPTIMIZECURSORS SQL compiler directive option for
the OCI and JDBC run-time systems.

e The SQL(TRANSACTION) directive now accepts an additional option, AUTO.
SQL(TRANSACTION=AUTO) is equivalent to SQL(AUTOCOMMIT). For new applications,
SQL(TRANSACTION) is the preferred method for specifying transaction options.

» PostgreSQL versions 3.2.2 and later are now supported with .NET COBOL.

» Operating System authentication for CONNECT statements is how supported for Oracle, DB2, and SQL
Server in the ODBC, ADO, and JDBC run-time systems.
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SQL Option for DB2
Back to the list

A problem that caused an AUTOBIND support routine invoked by the XDB ECM to fail by omitting the
drive letter in log file names when the specified drive letter was other than C: has been fixed.

3114069 (1110423)
The XDB ECM now supports the z/OS DB2 NEXTVAL reserved word as an ordinary identifier.

3120469 (1110834)

A problem that prevented the SQL Option for DB2 ECM from recognizing IN clause predicates
containing multiple group host variables has been fixed.

3115066 (1110310)

A problem that prevented the SQL Option for DB2 ECM from supporting the use of a collection ID for
validating SQL against z/OS DB2 with DYNAMICRULES BIND packages has been fixed.

3112996 (1110332)

A problem reading XDB translation files caused by stack initialization on Windows 10 has been
resolved.

3120927 (1110988)

A problem that resulted in an X352 thread access violation due to an improper reallocation of the parse
tree when using an inner join to a table expression containing a scalar subquery has been fixed.

3132740 (1111977)
A problem with CASE expressions resolving host variables has been resolved.

3131966 (1111932)

A problem with the lexical analysis of a PARTITION BY SIZE clause on a CREATE TABLE statement
when the integer constant and the "G" indicating gigabytes were not separated by a space character
has been fixed.

3129670 (1111676)

An issue with a correlated subquery not returning results due to a problem with the correlation variable
has been resolved.

3114811 (1110283)

A problem with the query optimizer incorrectly identifying the step for predicate evaluation of a join
predicate containing a column and an expression has been resolved.

3114809 (1110284)

A problem that caused an X352 thread access violation on a VIEW definition containing a select item of
the form name.* has been fixed.

3114210 (1110228)

An access violation caused by a long UNC path for the Roaming APPDATA directory on a Windows
machine has been resolved.

3112201 (1110021)

A problem that caused the XDB engine optimizer to return an empty result set for range predicates on
join conditions has been fixed.

3111742 (1109957)

A problem with the first FETCH operation against a rowset cursor containing a UNION ALL with host
variables has been resolved.

3110071 (1109893)
An issue with a LEFT OUTER JOIN operation not retrieving all result set rows has been resolved.

3104216 (1109202)
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A problem with XDB engines not allowing a GROUP BY to contain an item not in the projection list has
been fixed.

3103832 (1109175)
A problem that caused a PDMP272 — xdb Inner Join Problem message has been fixed.

2887796 (1108361)

The Stored Procedure Test tool now sizes the Results tab in the same way as it sizes the other tabs.

3148319 (1113402)

A problem with DSNUTILB that occurred when loading a table containing a VARCHAR field has been
resolved.

3128931 (1111587)

XML Support
Back to the list

cbl2xml will now work successfully under AlIX 7 32-bit.
3109051 (1109699)

The XML run-time now handles UTF-16 XML documents correctly.

3147256 (1113357)

The XML run-time system now correctly sends the XML instance document as an HTTP POST request
to the URL specified on UNIX platforms.

3145761 (1113163)

An RTS 164 error (Run-Time subprogram not found) no longer occurs on some very old versions of
Windows when parsing XML.

3142315 (1113028)

The XML run time now correctly sends the XML instance document as HTTP POST request to the URL
specified.

3135893 (1112298)
XMLPARSE now returns the full UTF-8 string when XMLPARSE(COMPAT) is specified.

3126921 (1112286)

zIServer

Back to the list
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The mfawrapperec.dll was only supplied as 32-bit version in the PU1 cab. It is now supplied as both 32
and 64-bit versions. This resulted in an error when trying to perform a MFA z/OS Mainframe connection.

3122545 (1111119)

IVPHOLD member was missing parameters on the EXEC line which caused the z/Server Holder to fail
to start. The supplied member has been updated.

3119820 (1110779)

zServer has been enhanced to handle passwords ("pass phrases") of length up to the RACF mandated
limit of 100 characters. The pass phrases can contain alphanumeric, nationals (@,#,$), special
characters and blanks (trailing blanks will be removed). The initial pass phrase must be set by a RACF
administrator.

3109741 (1110526)

Any advanced parameters entered for a holder, a scheduler or a user server are now correctly saved to
XML.



The z/Server Session ID support was enabled despite being disabled in configuration file. This is now
fixed.

3138523 (1112812)

When using the Eclipse JES Explorer function, users are only able to browse and delete jobs they own.
That is, jobs that they have submitted.

3109690 (1109793)

When using an XML configuration file where the Scheduler port range was invalid z/Server continued to
start up when it should have failed, which could result in it terminating abnormally. It now shuts down
correctly.

z/Server now correctly recognizes when a port is unavailable when trying to start a User Server. Rather
than fail to start, the User Server attempts to use the next available port in the User Server port range.

3124411 (1111274)

Resolved Issues
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Other Issues Resolved In This Release

The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

. 2879380 (1107250)
. 2881923 (1109518)
. 2913358 (1110961)
. 3145394 (1113143)
. 3142564 (1112892)
. 3129260 (1111765)
. 3117914 (1111288)
. 3143624 (1113310)
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Unsupported Functionality

This section includes information about features or functionality that are no longer supported.

« The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation

Installing Visual COBOL for Eclipse

Installation

Before Installing

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows
System Requirements for Visual COBOL for Eclipse (Windows)

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Visual COBOL

2.6GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

f Note:

e Support for development on Windows 8 and Windows Server 2012 has been discontinued. These
platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are
supported.

» Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file
does not install some of the components. See Issues with the Installation in Known Issues and
Restrictions.

» Visual COBOL enables you to produce both 64-bit and 32-bit applications on 64-bit operating
systems.
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Software requirements
i Note: This product includes OpenSSL version 1.0.2n.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Eclipse requirements
* The setup file installs Visual COBOL and the 64-bit Eclipse 4.7.

Some earlier versions of Eclipse are also supported. See Installing Visual COBOL into other instances
of Eclipse in the Advanced Installation Tasks.
* Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file does
not install some of the components. See Issues with the Installation in Known Issues and Restrictions.
« Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to create
both 32-bit and 64-bit applications.

Software requirements

» Oracle's Java Platform (64-bit) version 1.8 or later is required to run the Eclipse IDE; however, the
recommended minimum version is Java 1.8.162 (64-bit), which the Windows product installation will
install if it detects an older version. Java 7, 8 (32 or 64-bit versions), and Java 9 (64-bit version only) are
supported for executing JVM COBOL code and for native COBOL and Java interoperability. You can
download Oracle's Java from Oracle's Web site and install it anywhere on your machine.

Note: To skip installing Java 1.8.162 as part of the product installation, run the setup file with the
skipjre=1 command line option.

* Visual COBOL requires:

* A 32-bit Java installation if using the 32-bit Eclipse.
e A 64-bit Java installation if using the 64-bit Eclipse.

* The setup file also installs .NET Framework v4.6.1 and the Microsoft's Visual C++ 2010 and 2012
Redistributables.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.

1+, Important: For local servers, you do not need to install the Micro Focus License Administration tool
% separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows

To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file.
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Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Product Co-Existence

f Note: The following applies to Windows only.

» Visual COBOL and COBOL Server cannot coexist on the same machine.
« Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:

« Visual COBOL and Enterprise Developer cannot coexist on the same machine.

« You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

On UNIX

System Requirements for Visual COBOL for Eclipse (UNIX)

Hardware Requirements for Visual COBOL for Eclipse

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:

Platform Installer type Setup Disk space Disk space Sentinel RMS
file size required for required for license
the installation running server

the product

x86-64 Micro Focus 905 GB 3.62GB 1.81 GB 50 MB
running Red

Hat Linux

x64 running Micro Focus 781 GB 3.12GB 1.56 GB 50 MB
SUSE SLES

Operating Systems Supported
f Note: You can produce both 64-bit and 32-bit applications on 64-bit operating systems.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Eclipse requirements

* Visual COBOL installs the 64-bit Eclipse IDE by default and requires a 64-bit Java installation.

e On SUSE 12, you can only install and use the 64-bit version of Visual COBOL.

e On other platforms, Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-
bit Eclipse to create both 32-bit and 64-bit applications.
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The setup file installs Visual COBOL and the 64-bit Eclipse 4.7. After the installation, you can install

Visual COBOL as a plug-in into other Eclipse installations available on the same machine. The

supported versions are 4.6, and 4.7 for both the 32-bit and the 64-bit Eclipse. See Installing Visual

COBOL into other instances of Eclipse.

Note: On Red Hat platforms, you need Red Hat 7 or later, if you want to install Visual COBOL into
Eclipse 4.8.

Other software requirements

Before installing this product, you must have the following software installed on your computer:

The unzip utility is required by the setup file.

The "ed", "sed" and "tar" utilities must be installed and added to the PATH.

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems

but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

Required libraries - the 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating

Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before

you start the installation.

Library 32-bit 64-bit Platform
Library Library .
Ve e s390 SUSE 12 Red Hat 6.x Red Hat 7
glibc glibc-*.i686  glibc- glibc-*.s390 X X
*x86_64
libgcc libgcc-*.i686  libgce- libgce-*.s390 X X
*x86_64
libstdc++ libstdc++- libstdc++- libstdc++- X X
*.i686 *x86_64 *.s390
glibc-locale  glibc- glibc-locale-2 N/A X
locale-32bit
gtk2 N/A libgtk-2_0-0- N/A X
2
gtk2 N/A gtk2-tools-2  N/A
gtk2 N/A libXcomposit N/A X
el-0
gtk2 N/A libgdk_pixbuf N/A X
-2_0-0-2
gtk2 N/A gdk-pixbuf-  N/A X
query-
loaders-2
gtk2 N/A libjasperl-1  N/A X
gtk2 N/A gtk2- N/A X X
*x86_64
gtk2-x11 N/A libgthread-2_ N/A X
0-0-2
libXtst N/A libXtst6-1 N/A X

Installation

57



Library 32-bit 64-bit Platform
Library Library N
Name Name s390 SUSE 12 Red Hat 6.x Red Hat 7
libXtst N/A libXtst- N/A X X
*.x86_64
glibc-devel glibc-devel-  glibc-devel- N/A X X
*.1686 *x86_64
PackageKit- N/A PackageKit- N/A X
gtk gtk-module-
*.x86_64
PackageKit- N/A PackageKit- N/A X
gtk3 gtk3-module-
*.x86_64
gtk2-engines N/A gtk2- N/A X
engines.*.x8
6_64
libcanberra- N/A libcanberra- N/A X X
gtk2 gtk2-
*.x86_64
webkitgtk N/A webkitgtk.x8 N/A X
6_64
webkitgtk3 N/A webkitgtk3.x  N/A X
86_64
xterm Any version  Any version  Any version X X X
unzip Any version  Any version  Any version X X X
libgnome N/A libgnome.x86 N/A X X
_64
gcc? gcc*.i686 gcc*x86_64 X X X X

f Note:

1 On SuSe 12, you can only install the 64-bit version of Visual COBOL. The glibc-locale-32bit
library is still required by the SafeNet Sentinel licensed components.

« * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for
the GNU Project Debugger) can be installed from the install media for your OS.

» 20n Red Hat these libraries are required to enable COBOL to compile.

« Libraries marked with an 'X' are not included in the platform and need to be installed separately.

Visit the Red Hat Web site for more information.

e Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

« Oracle's Java Platform (64-bit) version 1.8 or later is required to run the Eclipse IDE; however, the
recommended minimum version is Java 1.8.162 (64-bit), which the Windows product installation will
install if it detects an older version. Java 7, 8 (32 or 64-bit versions), and Java 9 (64-bit version only) are
supported for executing JVM COBOL code and for native COBOL and Java interoperability. You can
download Oracle's Java from Oracle's Web site and install it anywhere on your machine.

Before you start the installation, you need to set the environment as follows:
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* You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 64-bit Java installation or the installation terminates. For example, execute the following:

export JAVA HOME=j ava_ install _dir

where java_install_dir is the path to the JAVA installation directory such as Zusr/java/javan. n
* You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:
export PATH=$JAVA HOME/bin:$PATH

* You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: For local servers, you do not need to install the Micro Focus License Administration tool
" separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.

-.-;"_:
-

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX

To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file.

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

imtkmake
Back to Top

On AIX v7.2, you must install IBM's patch APAR 1J04075 in order for imtkmake -genclient to work correctly.
See http://www.microfocus.com/docs/links.asp?vc=IBM_APAR_1J04075 for details about how to install the
patch.

Browser
Back to Top

Browser versions which can be used for embedded browser support (such as SWT) and their
corresponding Eclipse versions are listed here.

Note: Eclipse 4.5 and newer support Mozilla 1.4 GTK2 - 1.7.x GTK2, XULRunner 1.8.x - 1.9.x, 3.6.x,
10.x, 24.x and 31.x (but not 2.x nor other unlisted versions), WebKitGTK+ 1.2.x and newer (Eclipse
4.5 support for XULRunner 31.x is not available on Linux due to Bug 467646.). For Eclipse 4.6 you
must install a 64-bit browser version.

UNIX and Linux Installer Issues

» If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without
loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.
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Installing on Linux

On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

« Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
* Untar the distribution into a location different from the one used for the 32-bit Java version. For example,
untar in /Zusr/local/java64 and not in Zusr/local/java.

e Set JAVA HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and
run Visual COBOL.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify -

ESadminlID=[ User | D] onthe command line so it is used by the installer.

License Server
You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.l ocal domai n localhost
| P machi nel onghost nanme nachi neshort host nane

where IP is the unigue IP address of the computer in xx.xx.xx.xx format.

Basic Installation

The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

On Windows

Installing on Windows

i Note:

» This version of the product is a full install.

» If you have an earlier version of Visual COBOL installed on your machine, check Installing as an
Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL.:
1. Run the vce_40.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.7 64-bit, with the Micro Focus plugins already
installed, in the C:\Users\Public\Micro Focus\Product Nanme\eclipse directory.
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The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks. For
example, to stop the product installation from installing the version of Java shipped with the product,
run the setup file from the command line with the skipjre=1 command line option; otherwise, if the

installation detects a version of Java older than the shipped version, it will install the shipped version.

On UNIX

Installing the software

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing Visual COBOL on UNIX and Linux and a standard RPM (RPM Package
Manager) installer for installing Visual COBOL on Linux. See your product Help for instructions on
how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:
chmod +x setup_visualcobol deveclipse 4.0 platform
2. Run the setup file with superuser permissions:
./setup_visualcobol deveclipse 4.0 platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into Zopt/microfocus/VisualCOBOL, (COBDIR). A

full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.

To install in a different location use the —instal I location=""Location' parameter to specify an
alternative directory location. For example:

-/setup_visualcobol deveclipse 4.0 platform -installlocation="full path of
new | ocation"

i Note: You can use variables when specifying an absolute path for —instal l location. For
example, the following examples are equivalent:

—-installlocation="/home/myid/i nstal | di r"
—-installlocation=""$HOME/i nstal | di r *

You can see details about which additional parameters can be passed to the install script if you enter
the —help option.

f Note:

» The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:

. /setup_visualcobol deveclipse 4.0 pl atform -skipsafenet

« To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or

shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.
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Setting up the environment

If you have installed the product to a directory other than the default one, you need to set the environment
as described below.

i Note: The default directory is /opt/microfocus/Visual COBOL/.

1. To set up your product, execute:
. <product-install-dir>/bin/cobsetenv
2. To verify that your product is installed, execute:
cob -V

Important: These commands set the environment only for the current shell. You need to execute
* them for each new shell that you start.

=
-~

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as Zetc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. Itis
not compatible with C-shell or pre-XPG4 Bourne shell.

Starting the product
To start Eclipse:
« If you are using a GUI interface, double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh
« If you are using a hon-GUI interface, such as a terminal emulator, type the following from a command
prompt:
eclipse

Advanced Installation Tasks

This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

* Installing as an Upgrade - included in these Release Notes
e Command line installation options - included in these Release Notes

« Installing using an RPM installer on Linux - available in the product Help and on the Product
Documentation pages on Micro Focus SupportLine

» Installing into other instances of Eclipse - available in the product Help and on the Product
Documentation pages on Micro Focus SupportLine

< Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product
Documentation pages on Micro Focus SupportLine

See this information on the Product Documentation pages on Micro Focus SupportLine - for Visual COBOL
for Eclipse for Windows click here and for Visual COBOL for Eclipse for UNIX click here.

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine for
Visual COBOL Development Hub.

On Windows
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Installing as an Upgrade

Installing this release as an upgrade will automatically uninstall any Patch Updates of the older version of
the product you have installed on your machine.

« Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Visual COBOL Installation Options

You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (instal Ifolder=pat h), user information, and which
features to install. You must execute the command with superuser permissions.

To see what parameters you can use, execute the following from the command line:
install-file /help

where install-file for the following products is as follows:
Visual COBOL vce_40.exe

See the Examples section further in this topic for examples of some of the parameters you can use.

Directory considerations

« You must have read and write access for every directory accessed during the installation.
* You can override the default installation folder using the Instal IFolder parameter.

» Installing creates a group of log files prefixed Micro_Focus__in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:

/log drive:\path\ LogFi | enane

Installing silently
Use the /g parameter to install silently:

start /wait install-file.exe /g [paraneters]

Examples

» To silently install Visual COBOL into a directory other than the default:
start /wait vce_40.exe /q InstallFolder=c:\DirectoryName

» If you want to silently install the Eclipse IDE in a location other than the default, execute:
start /wait vce_40.exe /q InstallFolder2=c:\EclipselnstallDirectory

» To skip installing JRE when installing Visual COBOL:
start /wait vce_40.exe /q skipjre=1

On UNIX

Installing as an upgrade

This release works concurrently with the previous version of Visual COBOL, so you do not need to uninstall
it.
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Install the latest version in a different location and set the environment to point to it. To do this, run the
Visual COBOL installer with the —installlocation option:

1. Execute the following command:
. /Zlnstall File -installlocation="/opt/microfocus/VisualCOBOL eclipse"

f Note: You can use variables when specifying an absolute path for —instal llocation. For
example, the following examples are equivalent:

—-installlocation="/home/myid/i nstal | di r"
—-installlocation="$HOME/i nstal I di r "
2. Execute cobsetenv to set the environment and point to the new install location:
. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installation Options

Installing into a different location

To install in a different location use the —instal I location=""Location' parameter to specify an
alternative directory location. For example:

./setup_visualcobol _deveclipse 4.0 platform -installlocation="full path of
new | ocati on"

i Note: You can use variables when specifying an absolute path for —instal Il location. For
example, the following examples are equivalent:

—-installlocation="/home/myid/i nstal | di r "
—-installlocation=""$HOME/i nst al | di r **

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Skip Java Check

To skip the Java version check, use the —skipjavachk option. This skips the parts of the installation that
require Java, for example, the Eclipse installation. This can be used when you do not have Java on your
path and want to perform a custom installation. You can then manually configure the plug-ins as required:

./setup_visualcobol deveclipse 4.0 pl atform -skipjavachk

Skip Installing Eclipse

To skip the installation of Eclipse, use the -skipecl ipse option. This enables you to install Visual
COBOL into your own version of Eclipse.
./setup_visualcobol_deveclipse_4.0_pl at f orm -skipeclipse

i Note: You need to install the COBOL plug-ins manually.

Installing into a 32-bit Version of Eclipse

To skip the installation of the shipped Eclipse version but still install the plug-ins, use the -32bit option.
This enables you to install your own 32-bit version of Eclipse and manually install the required Visual
COBOL components.

-/setup_visualcobol deveclipse 4.0 platform -32bit
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Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog=""Y/N"" ]
[ -ESadminID="User I D" ] [ -CASrtDir="| ocation"™ 7], where:

-ESsyslLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, ~-ESadminID=""esadm". The default user ID is the one that runs the installer.

-CASrtDir  Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

—silent -lacceptEULA

For example, execute:
setup_fil enanme —silent -lacceptEULA

After Installing

« See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.

e Check the Product Documentation section of the Micro Focus SupportLine Web site for any updates to
the documentation which might have been uploaded.

On Windows

Configuring Visual COBOL

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.

2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.

From the Open Perspective dialog box, click the perspective you want to reset.
Click OK.

Click Window > Perspective > Reset Perspective.

When prompted, click Yes.

Reapply any customizations.

No ok

Installing X Windows on Windows

Some features of Visual COBOL for Eclipse on Windows require an X Windows installation, hence Micro
Focus ViewNowX is provided with the product.
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To install ViewNowX:

1. Using Windows Explorer, navigate to the folder that contains the ViewNowX executable. By default, this
is WProgramFiles(x86)%\Micro Focus\Visual COBOL\ViewNowX.

2. Execute ViewNow_X_Server .exe and then vnx_HF_ 11327 .msp in that folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing on Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

/1n, Important: The installer creates separate installations for Micro Focus Visual COBOL and Micro
“*= Focus License Administration. Uninstalling only Visual COBOL does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /Zuninstall

On UNIX

Configuring Visual COBOL

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.

2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.

3. From the Open Perspective dialog box, click the perspective you want to reset.



Click OK.

Click Window > Perspective > Reset Perspective.
When prompted, click Yes.

Reapply any customizations.

No ok

Configuring the Environment for Developing RDBMS Applications on UNIX

i Note:

If you are working with remote projects, you need to configure the environment before you start the
remote server process.

» On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.

4. If working with Pro*xCOBOL/Cobsql applications you need to set COBOPT. This sets the appropriate
linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Repairing

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:
1. Execute as root the Uninstal l_VisualCOBOLEclipse4.0.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the Unlnstal IMFLicenseServer .sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Visual COBOL Development Hub
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Before Installing

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

UNIX and Linux Installer Issues

« If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without
loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.

Installing on Linux

On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

« Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
« Untar the distribution into a location different from the one used for the 32-bit Java version. For example,
untar in /Zusr/local/java64 and not in /Zusr/local/java.

e Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and
run Visual COBOL.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify -

ESadminlID=[ User | D] on the command line so it is used by the installer.

License Server
You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.l ocal domai n localhost
| P machi nel onghost name nachi neshort host nane

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

System Requirements for Visual COBOL Development Hub

Hardware Requirements

The disk space requirements are approximately:


http://www.oracle.com/technetwork/java/javase/install-linux-64-rpm-138254.html

Platform Installer type Setup Disk space Disk space Sentinel RMS
file size required for required for license
the installation running server
the product
POWER Micro Focus 462 MB 1.85GB 924 MB 41 MB
running AlIX
HP 1A Micro Focus 847 MB 3.39GB 1.74 GB 79 MB
System Z Micro Focus 382 MB 1.53GB 764 MB 39 MB
running Red
Hat Linux
x86-64 Micro Focus 455 MB 1.82 GB 910 MB 50 MB
running Red
Hat Linux
ppc64le Micro Focus 267 MB 1.07 GB 534 MB 1 MB
running Red
Hat Linux
SPARC Micro Focus 456 MB 1.82 GB 912 MB 41 MB
running
Solaris
x86-64 Micro Focus 431 MB 1.72GB 862 MB 33 MB
running
Solaris
System Z Micro Focus 280 MB 1.12GB 560 MB 39 MB
running SUSE
SLES
x64 running Micro Focus 333 MB 1.33GB 666 MB 50 MB
SUSE SLES
ppc64le Micro Focus 247 MB 988 MB 494 MB 1 MB
running SUSE
SLES

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
y Note: This product includes OpenSSL version 1.0.2n.

Before installing this product, you must have the following software installed on your computer:

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not

installed by default. Use your UNIX/Linux installation media to install it.

The "ed", "sed" and "tar" utilities must be installed and added to the PATH.
On SUSE 12, you can only install and use the 64-bit version of Visual COBOL.

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems

but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --

version at the command line.

Required libraries for Red Hat and SUSE Linux platforms - the installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product

to install and work correctly.
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If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.

Table 1: Default Libraries

The following table shows which of the required libraries are not installed by default on the specified platforms - X
indicates the libraries are missing.

Library 32-bit 64-bit s390 Platform
Library Library Librarv Name ]
Name Name y SUSE 12 Red Hat 6.x Red Hat 7
glibc glibc-*.i686 glibc- glibc-*.s390 X X
* x86_64
libgcc libgcc- libgce- libgcc-*.s390 X X
*.i686 * x86_64
libstdc++ libstdc++-  libstdc++-  libstdc++-*.s390 X X
*.i686 * x86_64
glibc-devel glibc-devel- glibc-devel- glibc-devel-*.s390 X X
*.i686 * x86_64
glibc-locale glibc- glibc- N/A X
locale-32bit locale-2
gtk2 N/A libgtk-2_0- N/A X
0-2
gtk2 N/A gtk2- N/A X
tools-2
gtk2 N/A libXcompos N/A X
ite1-0
gtk2 N/A libgdk_pixb N/A X
uf-2_0-0-2
gtk2 N/A gdk-pixbuf- N/A X
query-
loaders-2
gtk2 N/A libjasperl-1 N/A X
gtk2 N/A gtk2- N/A X X
* x86_64
gtk2-x11 N/A libgthread- N/A X
2 _0-0-2
libXtst N/A libXtst6-1  N/A X
libXtst N/A libXtst- N/A X X
* x86_64
glibc-devel glibc-devel- glibc-devel- N/A X X
*.i686 * x86_64
PackageKit N/A PackageKit N/A X
-gtk -gtk-
module-
* x86_64
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Library 32-bit 64-bit s390 Platform
Library Library .
Lib N
Name Name Ibrary Name SUSE 121 Red Hat 6.x Red Hat 7
PackageKit N/A PackageKit N/A X
-gtk3 -gtk3-
module-
*x86_64
gtk2- N/A gtk2- N/A X
engines engines.*.x
86_64
libcanberra N/A libcanberra N/A X X
-gtk2 -gtk2-
*x86_64
webkitgtk ~ N/A webkitgtk.x  N/A X
86_64
webkitgtk3  N/A webkitgtk3. N/A X
x86_64
xterm Any Any Any version X X X
version version
unzip Any Any Any version X X X
version version
libgnome  N/A libgnome.x N/A X X
86_64
gec? gceti686  gec*x86_6 X X X X
4

Visit the Red Hat Web site for more information.

e 10n SuSe 12, you can only install the 64-bit version of Visual COBOL. The glibc-locale-32bit library
is still required by the SafeNet Sentinel licensed components.

» 20n Red Hat these libraries are required to enable COBOL to compile.

* Oracle's Java Platform (64-bit) version 1.8 or later is required to run the Eclipse IDE. The recommended
minimum version is Java 1.8.162 (64-bit). Java 7, 8 (32 or 64-bit versions), and Java 9 (64-bit version

only) are supported for executing JVM COBOL code, and for native COBOL and Java interoperability.

You can download Oracle's Java EE from Oracle's web site and install it anywhere on your machine.

i Note:

e On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. If you install IBM's JDK 8, on AIX you must install its latest fix - JDK 8
SR5 FP16. You can get IBM's AIX JDK from IBM's Web site.

e On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

e On Solaris platforms (both SPARC and Intel) only the 64-bit version of Java 8 and later is

supported.

To execute JVM COBOL code, you need to set the environment as follows:

* You need to set the JAVA_HOME environment variable. When installing the product, set this variable to

a 64-bit Java installation or the installation terminates. For example, execute the following:

export JAVA HOME=j ava_install _dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan. n
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* You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA HOME/bin:$PATH

* You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: For local servers, you do not need to install the Micro Focus License Administration tool
’ separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.

=
-~

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements for Visual COBOL Development Hub

To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file.

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Basic Installation

The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

Installing Visual COBOL Development Hub

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_visualcobol devhub 4.0 platform

2. Run the installer with superuser permissions:
./setup_visualcobol devhub 4.0 platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

The COBOL environment is installed by default into Zopt/microfocus/VisualCOBOL, (COBDIR).


http://supportline.microfocus.com
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SafeNet Sentinel considerations

« The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the —-skipsafenet option, which skips the
installation of SafeNet:

-/setup_visualcobol _devhub_ 4.0 pl at f orm -skipsafenet

« To protect the SafeNet Sentinel installation from accidental updating you can create an empty file

named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

i Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks

This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:
» Installing as an Upgrade - included in these Release Notes

« Command line installation options - included in these Release Notes
« Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter

« Installing into other instances of Eclipse - available in the product Help and in the Micro Focus
Infocenter

« Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus
Infocenter

See this information in the Micro Focus Infocenter - for Visual COBOL for Eclipse for Windows click here
and for Visual COBOL for Eclipse for UNIX click here.

Click here to see this information on the Micro Focus Infocenter for Visual COBOL Development Hub.

Installing as an Upgrade

This release works concurrently with the previous version of Visual COBOL Development Hub, so you do
not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Visual COBOL Development Hub installer with the —installlocation option:

1. Execute the following command:
/lnstall File -installlocation="/opt/microfocus/VisualCOBOL"
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i Note: You can use variables when specifying an absolute path for —instal l location. For
example, the following examples are equivalent:

-installlocation="/home/myid/i nstal | di r"

—-installlocation=""$HOME/i nstal | di r **
2. Execute cobsetenv to set the environment and point to the new install location:
- <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Visual COBOL Development Hub Installation Options

Installing into a different location

To install in a different location use the —instal Il location=""Location' parameter to specify an
alternative directory location. For example:

-/setup_visualcobol _devhub 4.0 pl atform -installlocation="full path of new
| ocation"

y Note: You can use variables when specifying an absolute path for —instal l location. For
example, the following examples are equivalent:

-installlocation="/home/myid/i nstal [ di r "
—-installlocation="$HOME/i nstal | di r*

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog=""Y/N"" ]
[ -ESadminID=""User ID" ] [ -CASrtDir="l ocati on™ 7], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, ~-ESadminID=""esadm". The default user ID is the one that runs the installer.

-CASrtDir  Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir=""/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

—silent -lacceptEULA

For example, execute:
setup _fil enane —silent -lacceptEULA

74 | Installation



After Installing

e The information about Visual COBOL Development Hub is part of the Visual COBOL for Eclipse product
help.

* Check the Product Documentation section of the Micro Focus SupportLine Web site for any updates to
the documentation which might have been uploaded.

Setting up the product

If you have installed the product to a directory other than the default one, you need to set the environment
as described below.

i Note: The default directory is /opt/microfocus/Visual COBOL/.

1. To set up your product, execute:
. <product-install-dir>/bin/cobsetenv
2. To verify that your product is installed, execute:
cob -V

Important: These commands set the environment only for the current shell. You need to execute
* them for each new shell that you start.

=
-~

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as Zetc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. Itis
not compatible with C-shell or pre-XPG4 Bourne shell.

f Note: If there are two or more products installed on the machine or the products are installed in non-
default locations then the Zopt/microfocus/logs/MicroFocusProductRegistry.dat data
file can be used to find the product locations.

The file contains the following entries:
[ Install Location J#[ Date of Installation J#[ Product Name ]

For example:

/home/userl/VisCobol30#2017-01-20#Micro Focus Visual COBOL Development Hub
3.0

/home/userl/CobolServer30#2017-01-20#Micro Focus COBOL Server 3.0

Configuring the Remote System Explorer Support

Note: The following only applies if you are using Visual COBOL Development Hub with Visual
COBOL for Eclipse.

The remote development support from the Eclipse IDE relies upon Visual COBOL Development Hub
running on the UNIX machine and handling all requests from the IDE for building and debugging programs.
Visual COBOL Development Hub provides a UNIX daemon, the Remote Development Option (RDO)
daemon, which initiates the RDO as Eclipse clients connect to it. Whichever environment is used to start
the RDO daemon will be inherited for all servers and hence all build and debug sessions.

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated on the Development Hub from one of the Eclipse clients, the
environment used will be inherited from whatever was used to start the daemon. A typical example of the
kind of environment that might need to be set up would include database locations and settings for SQL
access at build/run time.
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Starting the Daemon

/1. Important: Before starting the daemon you must have the following on your UNIX machine:

» A version of Perl.
» Aversion of Java 1.7 or later.
* The as (assembler) and Id (linking) programs on the path, as specified by the PATH environment
variable.
To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:
$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.

The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <l ow port>-<hi gh port>]
where:

e <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,
$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
» <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use
to communicate with Eclipse on the client machine.

For example,
$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999,

Stopping the Daemon

To stop the daemon, type the following command with superuser authority:
$COBDIR/remotedev/stoprdodaemon <port >

Repairing on UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOLDevelopmentHub4 .0.sh script in the $COBDIR/bin
directory.



Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the Unlnstal IMFLicenseServer .sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
i Note:

* When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid license either for a 30-day trial or full license of Visual COBOL in order to continue using the
product.

» If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

« The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

» If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To buy and activate a full unlimited license

To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

Windows

Windows 8.1 « From the Windows Start screen, click the License Administration tile

Windows 10 and Later .  grom your Windows desktop, click Start > Micro Focus License Manager >
License Administration

UNIX

Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool .sh

Installing licenses

You need either a license file (with a .mFlic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.

If you have a license file

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
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3. Do one of the following:

» Click Browse next to the License file field and select the license file (which has an extension
of .mFlic).

« Drag and drop the license file from Windows Explorer to the License file field.
* Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

Start Visual COBOL.

Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
Ensure | have a full Visual COBOL license is checked.

Click Browse next to the License file field.

Select the license file (which has an extension of .mFlic), and then click Open.

Click Finish to install the license.
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UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection

i Note:

« Itis not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows

1. Start Micro Focus License Administration.

2. Click the Install tab.

3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection

This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

Licensing Information
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Windows

1. Start Micro Focus License Administration.

Click Manual Authorization on the Install page.

Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:

WD

« If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

< If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.

5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.

Type the Machine ID in the Machine ID field.
Type your email address in the Email Address field.
Click Generate.

Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.

10.Click Install Licenses.

© o N

UNIX
In order to authorize your product you must have the following:

« Access to a computer which is connected to the Internet.

* Your authorization code (a 16-character alphanumeric string).

* The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

Click Generate.

Copy the licenses strings from the web page or the email you receive into a file.

Put the license file onto your target machine.

Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.

7. Enter the name and location of the license file.

o gk w

To obtain more licenses

If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.

Licensing Information
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Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:

« The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

« The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

« The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Support Resources > All Support Resources. In the Browse by Product
field, click the product you require support for. Click Log into SupportLine.

i Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

e The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

* The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusintl.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

* The name and version number of all products that you think might be causing a problem.

e Your computer make and model.

« Your operating system version number and details of any networking software you are using.
e The amount of memory in your computer.

« The relevant page reference or section in the documentation.

* Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
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(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportinfo, to create
either:

« a . logfile that contains the details about your environment, Micro Focus SupportLine products, and
settings.

e a .zip archive that includes the same information as the . 1og file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportinfo.exe is stored in <i nstal | - di r >\bin.
To run MFSupportinfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a . log file or a .zip archive as follows:

a. To create a - log file, click File > Save.

This prompts to save the . l1og file, MFSupportinfo_Log_Machi neNane_YYYY-MM-DD_HH-MW-
SS. 1og, in the %temp% directory.
b. To create a . zip archive, click Tools > Create Zip Package.

This creates a . zip archive, MFSupportinfo_Log_Machi neNanme_YYYY-MWDD_HH-MV-
SS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either

the . log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mFsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mFsupport:

1. Starta UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpol I . txt, in that directory.
4. When the script finishes, send the mfpol I . txt file to your Micro Focus SupportLine representative.

i Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of Zopt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer

© Copyright 2019 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS 1S" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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